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This manual, as well as the software described in it, is provided 
under licence and may only be used or copied in accordance with 
the terms of that licence. The information in this manual is subject 
to change, without notice, and should not be construed as a 
commitment by HighWater Designs Limited. HighWater Designs 
Limited assumes no responsibility or liability for any errors or 
inaccuracies that appear in this manual. 

All rights reserved. No part of this manual may be reproduced or 
transmitted in any form, or by any means, without the prior 
written permission of HighWater Designs Limited.

Version 1.02 May 2008

Torrent and Q2 are registered trademarks of HighWater Designs 
Limited.

Cobra-8 is a trademark of HighWater Designs Limited.

Windows XP, Windows Server 2003, Windows 2000, Windows NT, 
Windows 95 and Windows 98 are registered trademarks of 
Microsoft Corporation.

QuarkXPress is a registered trademark of Quark Incorporated.

All other brand or product names are trademarks or registered 
trademarks of their respective companies or organisations.

HighWater’s contact information

HighWater Designs Limited
Cotswold Building
The Barlands
London Road
Cheltenham
Gloucestershire
UK
GL52 6UT

Telephone: +44 (0) 1242 542100
Fax: +44 (0) 1242 251600
Email: sales@highwater.co.uk
Web: www.highwater.co.uk

HighWater’s support department

Telephone: +44 (0) 1242 542102
Email: support@highwater.co.uk
Web: www.highwater.co.uk
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1.1
Ac
If yo
arou

‘Bookmarks’ window to navigate to the 
n of this manual. If the bookmarks are not 
okmarks tab (see below) to display them:

k to move to the relevant chapter. Click on 
sub-sections within a chapter.

s
 guide in Acrobat Reader you can use ‘hot 
o the section you want (when you place the 
ot link it turns into a hand icon). There are 

age: click on the entry to take you to the 

 you will find these throughout the manual, 
er to section 5.3 for instructions”. Click on 
nce to take you to the relevant page.

e: click on the page number for the index 
 to the relevant page.

Bookmarks
ng this guide

 Using this guide
 chapter includes the following sections:

1.1, Navigating around this guide in Acrobat Reader (p6).

1.2, Warnings and notes (p7).

1.3, Printing this guide (p7).

e: The instructions in this chapter refer to Acrobat Reader 
.

 Navigating around this guide in 
robat Reader
u are viewing this guide using Acrobat Reader you can move 
nd the guide using Acrobat’s navigation buttons:

1.1.1  Bookmarks
You can use Acrobat’s 
required chapter/sectio
visible, click on the Bo

Click on a bookmark lin
a  link to view the 

1.1.2  Using hot link
If you are viewing this
links’ to move quickly t
mouse cursor over a h
three types of hot link:

• On the Contents p
relevant section.

• Cross references:
for example, “Ref
the section refere

• On the Index pag
entry to take you

Go to the first page of the guide

Go back one page

Go forward one page

Go to the last page of the guide

Go back to previous view

Go forward to next view

Fit whole page in window

Bookmarks tab
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1.2.
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from
dam
instr

1.2.
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is guide

r, select Print… from the File menu to 
imilar to the following:

d printer from the Name pull-down menu.

erties button and select the Landscape 
 Layout tab.

Portrait orientation if you are printing the 

urn to the ‘Print’ dialog.

ons, as required, then click on OK to print 
 specified pages).
ng this guide

 Warnings and notes

1  Warnings
 warnings in this manual are mainly intended to protect you 
 injury and the Cobra-8 platesetter and your plates from 
age. Please read all warnings carefully and follow any 
uctions. Warnings are shown like this:

WARNING: When working with the Cobra-8 system you 
must protect yourself from injury and protect the 
Cobra-8 platesetter from damage.

2  Notes
notes in this manual give additional information on using the 
ra-8 system. Notes are shown like this:

Note: For most of the above operations, you can select more 
than one file at a time using the Shift and/or Ctrl keys on the 
keyboard.

1.3 Printing th
To print this guide:

1. In Acrobat Reade
display a dialog s

2. Select the require

3. Click on the Prop
orientation on the

Note: Select the 
manual 2-up.

4. Click on OK to ret

5. Set the other opti
this guide (or the
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2. Before you begin
This chapter includes the following sections:

• 2.1, Version information (p8).

• 2.2, Basic requirements for using the Cobra-8 system (p8).

• 2.3, Other manuals supplied with the Cobra-8 system (p8).

2.1 Version information
The information in this manual refers to the following 
software versions:

• Cobra Console v1.0.2.

• Torrent RIP v7.2.

• Queue Configuration v4.4.

• Cobra Layout Tool v1.0.0.

• Cobra Test Tool v1.0.0.

Note: Throughout this manual, vx.x or vx.x.x is used to indicate 
the relevant software version number.

2.2 Basic requirements for using the 
Cobra-8 system

Before you start working through this manual, please make sure 
that:

• You have carefully read the safety notices and information in 
chapter 3. This covers how to work safely with the Cobra-8 
system and how to stop the Cobra-8 platesetter in an 
emergency.

• You are familiar with Windows XP Professional and the 
platform(s) that you will be printing to Torrent from (for 
example, Macintosh OSX).

• You know how to print a job from a page make-up 
application, such as QuarkXPress.

• You have a basic knowledge of how the Torrent RIP works and 
how to use it (refer to chapter 6 for details on using the 
Torrent RIP).

Note: This guide assumes you will be using AppleTalk to print 
jobs from your page make-up workstation to the Torrent RIP. 
Refer to the Torrent User’s Guide for details about other 
methods of printing jobs to Torrent.

2.3 Other manuals supplied with the 
Cobra-8 system

The following manuals may also be supplied with the Cobra-8 
system:

Torrent User’s Guide
The Torrent User’s Guide gives full details on setting up and 
using the RIP. The Torrent User’s Guide is available in PDF 
format on the machine that Torrent is running on. To view the 
guide, select Start > Programs > HighWater Designs > 
Torrent vx.x > Torrent User Guide vx.x.

InkMonitor User’s Guide (optional)
InkMonitor is an optional software application that generates ink 
duct settings and/or ink duct control files suitable for automatic ink 
duct control on many different presses. This manual gives basic 
instructions for setting up the Cobra-8 system to use InkMonitor. 
However, you should also refer to the separate InkMonitor 
User’s Guide for full details on using the InkMonitor software. You 
can find the manual in PDF format on Pre-Press Solutions CD 1.
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 labels on your Cobra-8 machine. Please 
 all the necessary safety precautions, as 

ce
r and vacuum pumps conform to the 
d directives:

nformity
with: 
37/EEC
23/EEC

with:
55022
61000
60950-1:2001
 CFR47
60950-1:2001

 60825-1
FR 1040.10 & 1040.11

C Directives
with:
336/EEC
23/EEC as amended by 93/68/EEC

with:
55022: 1998 + A1:2002 + A2:2003-Class A
61000-3-2:2001
61000-3-3:1995
 CFR47 Parts 15.107 & 15.109-Class A

60950-1:2001
60950-1:2001

 60825-1:1994+A1 & A2
FR 1040.10 & 1040.11
lth, safety and conformance

Health, safety and conformance
 chapter contains important health and safety 
rmation. Please read it carefully and also refer to the 
ra-8 Safety Information manual for additional 
rmation.

 chapter contains the following sections:

3.1, Safety notices (p9).
3.2, Conformance (p9).
3.3, Working safely (p10).
3.4, Stopping the Cobra-8 platesetter in an emergency (p11).

 Safety notices

RNING: This equipment must be earthed. Cobra-8 
ires a single power outlet, accessible AT ALL TIMES and 
ted as close as possible to the Cobra-8 system.

ra-8 is a CLASS 1 EMBEDDED LASER product. Once the laser 
iage cover is removed, Cobra-8 becomes a CLASS 3B LASER 
ICE and appropriate safety precautions must be taken.

TION: The use of controls or adjustments or 
formance of procedures other than those specified 
ein may result in hazardous laser exposure.

RNING: When the laser cover is removed, the laser beam 
d in the Cobra-8 platesetter is harmful to the eyes. 
vicing and repair should be carried out by HighWater 
lified personnel only.

1  Laser properties
elength: 405 nm. Emission duration: continuous. Laser 
ut:Maximum 60 mW

3.1.2  Labels
There are a number of
ensure that you follow
indicated.

3.2 Conforman
The Cobra-8 platesette
following standards an

CE Declaration of Co
Directives complied 

98/
73/

Standards complied 
EN
EN
EN
FCC
IEC
BS
21C

Low Voltage and EM
Directives complied 

EMC: 89/
LVD: 73/

Standards complied 
EMC: EN

EN
EN
FCC

LVD: EN
IEC

LASER SAFETY: BS
21C
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 Cobra-8’s drum from damage
 do not put any object, other than a plate, 
m.

 plate from being fogged by light
, use the appropriate safety light (as 
 the plate manufacturer) to prevent fogging 

om is in use you need to prevent its door 
do this you could:

nal light on the brightroom to show when it 

e on the door to indicate that the 
 in use.

afety reasons, we recommend that you 
 brightroom door.

es not have a yellow filter, you can use the 
 to darken the monitor when there is a 

plates could be exposed to its light. Refer to 
etails about using Blackscreen.

ect the plate from unsafe light sources until 
ssed.

 plate from contamination
 unload a plate, avoid touching the part of it 
ed. You can wear special lint-free gloves to 
erprints on the plate.

Cobra-8’s drum for dust and other particles 
, as described in section 16.1.
lth, safety and conformance

 Working safely

RNING: You must work safely in order to protect 
rself from injury and the Cobra-8 platesetter from 
age. Please follow the instructions in this section 
fully.

er normal operating conditions it is not possible for you to 
e into contact with the laser beam when Cobra-8’s cover is 
. However, you, the user, must ensure that:
All access doors to the Cobra-8 room display the BSI-
approved warning symbol:

When engineers are working on the laser, no-one enters the 
room unless they are wearing safety goggles that meet 
approved standards.

You have received training on safety procedures, as well as 
instructions on how to operate Cobra-8.

Cobra-8 is never left in a condition where the operator can be 
exposed to the laser beam.

1  Protecting yourself from injury
Make sure that nothing (especially your clothing) gets trapped 
in Cobra-8’s cover.

The edges of a plate are sharp so take great care when 
handling plates and, in particular, keep the edges of the plate 
away from your face.

3.3.2  Protecting the
• To avoid damage,

into Cobra-8’s dru

3.3.3  Protecting the
• In the brightroom

recommended by
of your plates.

• While the brightro
being opened. To 

• Use an exter
is in use.

• Put a messag
brightroom is

WARNING: For s
DO NOT lock the

• If your monitor do
Blackscreen utility
danger that your 
section 5.5.2 for d

• After output, prot
it has been proce

3.3.4  Protecting the
• When you load or

that will be expos
avoid getting fing

• Regularly inspect 
and remove these
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5  Protecting your system from data loss or corruption
When you have finished using Cobra-8, you must always shut 
down the system properly to avoid data loss or corruption. 
Section 5.3 shows you how to shut down the Cobra-8 system.

 Stopping the Cobra-8 platesetter in an 
ergency
u need to stop the Cobra-8 platesetter immediately because 

otential injury or damage to a person or the Cobra-8 
esetter, then do any of the following:

Open the Cobra-8 platesetter’s cover. This will immediately 
stop the carriage and laser.

Note: If Cobra-8 was in its imaging cycle when the cover was 
opened, refer to section 9.6 for details of how the Cobra-8 
system will respond and how to restore the system to normal 
operation.

WARNING: Opening the cover while Cobra-8 is in its 
imaging cycle should be avoided. Only do this in an 
emergency situation.

Turn the Cobra-8 platesetter off using the power switch on 
the side of the machine.

Disconnect the system from the power source by removing its 
mains plug from the wall socket.

WARNING: Switching off Cobra-8 using the power 
switch or removing the mains plug without shutting the 
system down properly first is NOT recommended and 
should only be done in an emergency situation.
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4.1
High
wide
qua
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deta

8 platesetter
r images your plates. Its two main parts are 
age, as described next.

 load the plate. On or near to the drum you 

 — depending on the option purchased, 
ndard ‘U’ notch registrations:

 contacts — these are located in the 
elp you to position the plate correctly on the 

 LEDs and load button, also located on the 
xample:

Option 1 Option 2

tion 425mm 425mm

tion 780mm 830mm

Load button

istration LEDS

Lever

Locking wheel
oduction to the Cobra-8 system

 Introduction to the Cobra-8 
system

 chapter gives an overview of the whole Cobra-8 system. It 
des the following sections:

4.1, The Cobra-8 system (p12).

4.2, The Cobra-8 platesetter (p12).

4.3, The Cobra-8 platesetter in operation (p13).

4.4, The Cobra-8 workstation (p13).

4.5, Plate information (p15).

 The Cobra-8 system
Water’s Cobra-8 platesetter is designed to meet the needs of a 
 range of the pre-press and printing industry. It produces high 

lity, aluminium plates, which have the cleanness, accuracy and 
atability only achievable with digital imaging. The Cobra-8 
em has a modular design making it easy to install, set up and 
ntain.

Cobra-8 system’s two main components are:

The Cobra-8 platesetter, which images the plates.

The Cobra-8 workstation, which runs all the software 
required to process your jobs and output them to the Cobra-8 
platesetter.

next three sections describe the Cobra-8 system in more 
il.

4.2 The Cobra-
The Cobra-8 platesette
the drum and the carri

4.2.1  The drum
The drum is where you
will find the following:

• The register bar
there are two sta

• The registration
register bar and h
drum.

• The registration
register bar, for e

Inner registra

Outer registra

Reg
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•

•

•

4.2.
The

•

•

8 platesetter in operation
 Cobra-8 platesetter involves the following 

or output using the Cobra Console software.

to Cobra-8’s drum. When the plate is in the 
he vacuum is automatically applied to hold 
.

over.

es across the drum and the laser images the 
.

aged, the vacuum is automatically released. 
 the cover and remove the imaged plate, 

ing.

8 workstation
n is a high-performance computer, which is 
ftware you need to process your jobs and 
ra-8 platesetter.

n runs Windows XP Professional and the 
ftware applications:

le gives you full control of job output to the 
er, allowing you to view current, pending, 
rored jobs, delete and requeue jobs, as well 
various Cobra-8 software applications.
nd 8 for more information about using the 
oduction to the Cobra-8 system

The registration LEDs help you to position the plate correctly. 
You use the load button to prepare the drum for plate load 
and to release the vacuum from the plate.

The locking wheels and levers, located on the register bar, 
as shown in the previous diagram. These are used to switch 
between the inner and outer registrations. Please refer to 
section 9.2 for details on how to do this.

The vacuum channels — these apply a vacuum across the 
drum to hold the plate securely in place during imaging. Refer 
to section 9.3 for details on setting up the vacuum.

Note: The two vacuum units are positioned in the Cobra-8’s 
casing:

The lead screw, also called the ball screw — the carriage 
(see below) moves along this as the plate is imaged.

2  The carriage
 carriage sits above and to the left of the drum and contains:

The laser — this images the plate. 

The spinner — this directs the laser around the drum.

4.3 The Cobra-
Imaging a plate on the
steps:

1. You set up a job f

2. You load a plate in
correct position, t
the plate in place

3. Close Cobra-8’s c

4. The carriage mov
job onto the plate

5. Once the job is im
You can now open
ready for process

4.4 The Cobra-
The Cobra-8 workstatio
supplied with all the so
output them to the Cob

The Cobra-8 workstatio
following HighWater so

• Cobra Console
The Cobra Conso
Cobra-8 platesett
completed and er
as configure the 
See chapters 7 a
Cobra Console.

Vacuum units
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•
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•

l
ol helps to diagnose problems with the 
It also lets you check the laser power 
lates, and save system settings.
and 18 for more information about the 

tor (LRG)
res ‘view’ files for use with the Cobra 
tion 5.5 for more information about the Low 

to darken the computer monitor when you 
es. See section 5.5 for more information 
n.

tional)
ware calculates the amount of ink required 
ere relevant, this manual gives instructions 
 Cobra-8 system for use with InkMonitor.

efer to the InkMonitor User’s Guide for 
 about using InkMonitor.
oduction to the Cobra-8 system

Torrent RIP
HighWater’s Torrent RIP (based on the Harlequin RIP) 
accepts incoming PostScript/PDF files from the network and 
interprets them into bitmap TIFF files suitable for output to 
the Cobra-8 platesetter.

See chapters 6, 11 and 12, and the Torrent User’s Guide 
for more information about using the Torrent RIP.

Queue Configuration
The Queue Configuration application lets you create the 
Cobra Console queues, which output TIFF files from the 
Torrent RIP to the Cobra-8 platesetter.

See chapter 14, Appendix A and Appendix B for more 
information about creating queues using the Queue 
Configuration application.

Cobra Layout Tool
The Cobra Layout Tool lets you create layout (ICF) files for 
use with the Cobra Console. Layout files contain the plate 
and job position information that the Cobra Console needs 
when outputting your jobs to the Cobra-8 platesetter (and 
also information required for using InkMonitor if this 
application is installed with your Cobra-8 system).

See chapter 13 for more information about the Cobra Layout 
Tool.

Barcode Plate Requeue (BPR)
The Barcode Plate Requeue (BPR) option adds a barcode to 
your plates to allow you to quickly locate jobs for re-output.

See section 7.5 and Appendix C for more information about 
BPR.

• Cobra Test Too
The Cobra Test To
Cobra-8 system. 
setting for your p
See chapters 15 
Cobra Test Tool.

• Low Res Genera
This creates low-
Console. See sec
Res Generator.

• Blackscreen
You can use this 
are handling plat
about Blackscree

• InkMonitor (op
This optional soft
on the press. Wh
for setting up the

You should also r
more information
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 Plate information
Cobra-8 system supports the following plate types:

is is a 0.4D filter, which is different to the filter used for the 
r plates.

e: If you are considering changing the type of plate you use on 
Cobra-8 platesetter, the filter may need to be changed or 
oved. Please contact HighWater Designs or your support 
ider for more information about this.

1  Plate sizes
Cobra-8 platesetter can be used with plates between the 
wing sizes:

 maximum expose area varies, depending on how much of the plate sits in the 
ter bar (this area does not get exposed). Typically, this is 15 mm. Cobra-8 can 
se right up to the edges of the plate in the slow-scan direction.

te type Pos/neg Filter 
fitted

Plate type

a Lithostar Plus LAP-V / 
a-V

Positive Yes Silver

a Lithostar N91V Negative Yes* Photopolymer

 Film LP-NV Negative No Photopolymer

ak VioletPrint Negative No Photopolymer

ximum size 1080 x 850 mm
0.3 mm thick

Maximum expose area*
1080 x 835 mm

nimum size 510 x 400 mm
0.15 mm thick

Maximum expose area*
510 x 385 mm

Maximum size plat

Minimum size plate

1080 mm

510 mm

4
0
0
 m

m

Unimageable area at botto

Unimageable area at botto
of plate (typically, 15 mm

(typically, 15 mm)
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4.5.

4.5.
Plat

Neg

Pos

In e
pres
the 

Im
oduction to the Cobra-8 system

2  More information

3  Positive and negative working plates
es may be exposed in two different ways:

ative working plates
The laser exposes parts of the plate which will be inked on 
the press.

itive working plates
The laser exposes parts of the plate which will NOT be inked 
on the press, so all positive working plates are always 
exposed fully from edge to edge (in the slow-scan direction).

ither case, the physical appearance of the plate to go on the 
s will be the same (positive image, right reading), apart from 
unexposed grip area.

Plate thickness 0.15–0.3 mm

Grip area Typically, 15 mm at front edge of plate 
(this area does not get exposed)

aging resolution 2540 dpi / 100 dpmm at 150–200 lpi

Spot size 10 microns
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5.
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•

•
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5.1
pla
The 
job 
mak
work
part
prod
Cob
rview of using the Cobra-8 system

 Overview of using the 
Cobra-8 system

 chapter gives an overview of using the whole Cobra-8 system. 
cludes the following sections:

5.1, Outputting a job to the Cobra-8 platesetter (p17).

5.2, Starting the Cobra-8 system (p20).

5.3, Shutting down the Cobra-8 system (p20).

5.4, Cobra-8 status lights (p21).

5.5, The Low Res Generator (LRG) and Blackscreen (p21).

 Outputting a job to the Cobra-8 
tesetter
two diagrams on the following pages show how you output a 
to the Cobra-8 platesetter. First, you print a job from a page 
e-up workstation to Torrent (which runs on either a separate 
station or on the Cobra-8 workstation, depending on your 

icular system configuration). Torrent RIPs the job and 
uces TIFF bitmap files that you output to Cobra-8 using the 
ra Console.
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Co

orkstation

Cobra-8 platesetter

 Console

w

rview of using the Cobra-8 system

bra-8 system workflow (two-computer configuration)

Cobra-8 w

Cobra

Torrent RIP

Page make-up 
orkstation on the 

network

Job printed 
from page 
make-up 
application

Torrent workstation
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Co

w

Cobra-8 platesetter

 Console
rview of using the Cobra-8 system

bra-8 system workflow (one-computer configuration)

Page make-up 
orkstation on the 

network

Job printed 
from page 
make-up 
application

Cobra-8 workstation

Torrent RIP

Cobra
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5.2
To s

1.

2.

3.

4.

The

5.2.

If yo
Star
v1.x

Not
re-la
mac
with

wn the Cobra-8 system

u have finished using the Cobra-8 
ll the running applications properly (as 
tion) then shut down the workstation 
f the Cobra-8 platesetter and vacuum 
ut down the Cobra-8 system properly, 

s and lose data.

the Cobra-8 workstation:
ole, suspend processing (using the 
button in the top left-hand corner) and deal 
d Cobra plate operation.

button in the top right-hand corner of the 
indow . Any jobs that are currently being 
being output to the platesetter are 
 the Cobra Console quits.

er running applications.

s Start menu, select Shut Down….

n then click on the OK button.

nitor, if necessary.

he Cobra-8 platesetter:
rkstation has been shut down.

witch on the Cobra-8 platesetter.

uum units.

isconnect power completely from the 
tter, the AC power cord must be 
he wall outlet.
rview of using the Cobra-8 system

 Starting the Cobra-8 system
tart the Cobra-8 system:

Press the power switch on the right-hand side of the Cobra-8 
platesetter. The Cobra-8 platesetter starts up.

Switch on the vacuum units.

Switch on the Cobra-8 workstation and log on using the 
username Cobra with no password.

The Cobra Console (and any other required software 
applications) will launch automatically.

Note: If you have a two-computer configuration, the Torrent 
RIP resides on the second computer. If so, also start this 
computer and launch the Torrent RIP.

 Cobra-8 system is now ready for use.

1  Re-launching the Cobra Console

u need to re-launch the Cobra Console at any point, select 
t > Programs > HighWater Designs > Cobra Console 
.x > Cobra Console.

e: If you have any problems running the Cobra Console after 
unching it, close down all running applications, log off the 
hine and then log back on again using the username Cobra 
 no password.

5.3 Shutting do

WARNING: When yo
system, quit out of a
described in this sec
before you switch of
unit. If you do not sh
you may corrupt file

5.3.1  To shut down 
1. In the Cobra Cons

Pause/Resume 
with any requeste

2. Click on the Quit 
‘Cobra Console’ w
processed or are 
completed before

3. Close down all oth

4. From the Window

5. Select Shut dow

6. Switch off the mo

5.3.2  To switch off t
1. Make sure the wo

2. Press the power s

3. Switch off the vac

WARNING: To d
Cobra-8 platese
removed from t
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5.4
Ther
the 
the 

s Generator (LRG) and 

cludes two useful software utilities, the Low 
 and Blackscreen, as described below.

enerator (LRG)
r (LRG) launches automatically during the 
When a TIFF file has been output by Torrent 
aps directory (usually in 
\[sub-dir]), LRG produces a low-resolution 
 the Cobra Console.

w-res view file at 
ub-dir].

 need to protect your plates from being 
obra-8 workstation monitor has a yellow 

ct your plates from light. However, if you are 
plates or film in the same room as the 
u may find the Blackscreen utility useful for 

ograms > HighWater Designs > Cobra 
 Blackscreen.

 monitor will go dark.

nished loading/unloading the plate/film, 
sc key or double-click the mouse to exit 

R

O

O

O

O

Fla
rview of using the Cobra-8 system

 Cobra-8 status lights
e are two status lights (red and green) on the front panel of 
Cobra-8 platesetter. The different combinations of lights have 
following meanings:

5.5 The Low Re
Blackscreen
The Cobra-8 system in
Res Generator (LRG)

5.5.1  The Low Res G
The Low Res Generato
workstation’s startup. 
and arrives in the bitm
K:\PLOTDATA\BITMAPS
view file of it for use in

Note: LRG saves the lo
K:\PLOTDATA\VIEW\[s

5.5.2  Blackscreen
In the brightroom, you
exposed to light. The C
filter attached to prote
also using LAP-O type 
Cobra-8 platesetter, yo
blanking the screen.

To use Blackscreen:

1. Select Start > Pr
Engine v1.0.1 >

2. The workstation’s

3. When you have fi
either press the E
Blackscreen.

ed Green Meaning

ff Off

The Cobra-8 system is not ready.

ff On

The system is ready and idle, waiting for 
job output to commence or for the user to 
load/unload a plate.

ff Flashing 
slowly

A plate is being exposed.

ff Flashing 
quickly

The carriage is moving to the image start 
position or to the plate load position.

shing Off

An error has occurred. Restart the whole 
Cobra-8 system. If the error persists, 
contact your support provider.

On

[Any state]
An error has occurred. Restart the whole 
Cobra-8 system. If the error persists, 
contact your support provider.
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6.
The 
from
outp
bitm

This
the 

•

•

•

•

•

•

•

•

6.1
Befo
the 

•

•

llation engineer created one or more 
ps and input queues specifically for use with 
m. If there is more than one page setup or 
e sure you know the name, purpose and 
ne.

how to print a job from your page make-up 
, please refer to your page make-up 
ual for full details on printing jobs.

ting your jobs to Torrent via an AppleTalk 
efer to the Torrent User’s Guide, which 
ther methods of printing your jobs to 

t properly when you have finished using it.

f using the Torrent RIP
 your jobs and produce TIFF bitmap files, 
 to the Cobra-8 platesetter via the Cobra 
ives a basic overview of the Torrent RIP and 
obra-8 system. However, setting up and 

ially a complex task so, if you require more 
 and its many capabilities, you should refer 
 Guide.

f the Cobra-8 system involves the following 

RIP, if it is not already running.

t Torrent’s input queues, which let you send 
etwork to Torrent.

e-up workstation, open or create a job.

rrent from your page make-up application.
ng the Torrent RIP

 Using the Torrent RIP
first step in using the Cobra-8 system is to send your jobs 
 a page make-up application to the Torrent RIP, which will 
ut them as TIFF bitmap files. Later, you will output these 
ap files to the Cobra-8 platesetter via the Cobra Console.

 chapter shows you how to use the Torrent RIP and includes 
following sections:

6.1, Before you begin (p22).

6.2, Overview of using the Torrent RIP (p22).

6.3, Torrent’s main window (p23).

6.4, Page setups and input queues (p23).

6.5, The Output Controller (p24).

6.6, Printing a job to Torrent (p27).

6.7, When you have finished (p28).

6.8, Torrent’s toolbar (p29).

 Before you begin
re you start working through this chapter, please be aware of 
following:

Before you can print to Torrent you need to create the 
Cobra-8 print queue(s) on every computer that you will 
be printing from. This is covered in chapter 19.

You can use your usual page make-up and imposition 
software with the Torrent RIP if it can produce PostScript or 
PDF files.

• The Cobra-8 insta
Torrent page setu
the Cobra-8 syste
input queue, mak
settings of each o

• You should know 
application. If not
application’s man

• If you are not prin
network, please r
gives details on o
Torrent.

• Quit out of Torren

6.2 Overview o
You use Torrent to RIP
which you later output
Console. This chapter g
using it as part of the C
using Torrent is potent
information on Torrent
to the Torrent User’s

Using Torrent as part o
steps:

• Start the Torrent 

• If necessary, star
jobs across your n

• On the page mak

• Print the job to To
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•

•

6.3
If To
> P
vx.x

Torr

•

ining 12 buttons, which let you quickly 
ost commonly used menu options and 

tion 6.8 describes each of these buttons):

n the top right of the window), which shows 
ing (refer to the Torrent User’s Guide for 
t this):

 this large text area below the toolbar 
ss of jobs through Torrent, and displays 
 timing, errors, job completion, fonts, etc. If 
s with the RIP, check for error messages 

s and input queues
p specifies the settings to be applied to a 
esolution, page size, orientation, scaling, 
nd the ‘device’ a job is to be printed to). 
tion of settings requires a separate page 

ps have already been created for you by the 
gineer. Each of these page setups is 
 input queue, which lets you send jobs 

the Torrent RIP. Once your input queues 
 as described below, they appear as virtual 
make-up workstations on the network, and 
 directly to them.
ng the Torrent RIP

Optionally, use Torrent’s Output Controller to preview jobs 
and carry out job management.

Once the jobs have been output as TIFF files by Torrent, they 
will appear in the relevant queue in the Cobra Console for 
output to the Cobra-8 platesetter.

 Torrent’s main window
rrent is not already running, launch it now by selecting Start 
rograms > HighWater Designs > Torrent vx.x > Torrent 
. Torrent’s main window appears:

ent’s main window contains:

The menus, which contain all the commands needed to run 
Torrent:

• The toolbar conta
access Torrent’s m
dialog boxes (sec

• The status area (i
what Torrent is do
more details abou

• The RIP Monitor —
shows the progre
information about
you have problem
here.

6.4 Page setup
In Torrent, a page setu
job (for example, the r
screening, dot shape, a
Each different combina
setup. 

One or more page setu
Cobra-8 installation en
associated with its own
across the network to 
have been ‘broadcast’,
printers on your page 
you can print your jobs
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6.4.
You 
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•

•

•

Whi
Man
proc
(ass
mac

6.4.
Ther
inco
setu
any 

•

•

•

•

Whe
prin

put queues
ich input queues have been set up and are 

 Input Controller... to display the Input 

each input queue along with other 
ding its associated page setup.

ch required input queue is listed as On in 
n, otherwise you will not be able to print to 
broadcast the inputs. (To enable an input 
t and click the On button.)

nished, close the Input Controller.

 Controller
 Torrent you can use the Output Controller 
 the progress of those jobs through the RIP. 
ief overview of the Output Controller.

ut Controller is optional.
ng the Torrent RIP

1  Broadcasting the input queues
need to broadcast the input queues so that you can print a job 
orrent. To broadcast them, do any of the following:

Select Torrent > Start Inputs... (so that there is a tick next 
to it).

Press Ctrl-I on the keyboard.

Click the Start Inputs button  on the toolbar.

le the input queues are being broadcast, you will see the ‘Input 
ager Dial’. When it has finished, Torrent is ready to receive and 
ess incoming PostScript/PDF jobs from across the network 
uming that the print queues have been set up on those 
hines, as described in chapter 19).

2  Stopping the input queues
e are times when you need to stop the Torrent RIP accepting 
ming jobs (for example, when you are creating or editing page 
ps). To do this, you need to stop the input queues by doing 
of the following:

Select Torrent > Start inputs... (so that there is no tick 
next to it).

Press Ctrl-I on the keyboard.

Click the Stop Inputs button  on the toolbar.

Select Stop Input Queue from the Input Queue menu.

n the input queues have stopped you will no longer be able to 
t jobs to Torrent from across the network.

6.4.3  Viewing the in
In Torrent, to check wh
available:

1. Select Torrent >
Controller:

2. This window lists 
information, inclu

3. Make sure that ea
the Enable colum
it when you have 
queue, highlight i

4. When you have fi

6.5 The Output
When you print jobs to
to monitor and control
This section gives a br

Note: Use of the Outp
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To d
Con

The 
wait
will 
been
to s

Whe
the 
Que

The 
disk

The 

•

•

•

Thes

Not
Outp

b output
ut by the Torrent RIP, check the Disable 
cessing will stop once the current job has 

 does not stop jobs being printed to Torrent 
rk.

bs on screen
tput as TIFF files, you may want to preview 
ample, to make sure that jobs have 

ole also has an option to preview your jobs 
bra-8 platesetter.

obs to Torrent from your page make-up 
 the Disable output box on Torrent’s 
 to stop Torrent outputting the jobs as TIFF 

o disable output because you cannot 
le Torrent is outputting.

orrent (see section 6.6) then highlight one 
’s separations in the Active Queue and click 

ton.
lect more than one job separation using the 
 keys on the keyboard.
ng the Torrent RIP

isplay the Output Controller, select Output > Output 
troller. The following window is displayed:

Output Controller’s Active Queue contains pages that are 
ing to be output. Pages listed at the top of the Active Queue 
be printed first. The Held Queue contains pages that have 
 output (or you can move them there from the Active Queue 

uspend them).

n a page is being output, it is shown in the box at the top of 
Output Controller between the Active Queue and the Held 
ue.

number of pages in each queue, together with the amount of 
 space they use, is displayed below each queue.

Output Controller allows you to:

Suspend job output.

Preview jobs on screen.

Re-print, re-order, stop and remove jobs.

e functions are described in the following sub-sections.

e: Refer to the Torrent User’s Guide for full details on the 
ut Controller.

6.5.1  Suspending jo
To stop jobs being outp
output box. All job pro
been processed.

Note: Disabling output
from across the netwo

6.5.2  Previewing jo
Before your jobs are ou
them on screen, for ex
separated correctly.

Note: The Cobra Cons
before output to the Co

To preview your jobs:

1. Before you send j
application, check
Output Controller
files.
Note: You need t
preview a job whi

2. Print your job to T
or more of the job
on the Roam but
Note: You can se
Shift and/or Ctrl
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3.

4.

5.

6.

7.

-ordering, stopping and removing jobs
utput Controller to:

rag the job(s) from the Held Queue back to 
 To check or edit the settings before the job 
light the required job and click on the Info 
e Torrent User’s Guide for more 
 this).

r that jobs are printed: drag the job(s) to 
 in the Active Queue (jobs at the top of the 
 first).

s currently being printed: drag the job 
to either the Held Queue or the Active 

t has not yet been printed: drag the job 
ueue to the Held Queue.

ove a job from either queue: highlight 
n the Remove button. You will be asked to 

val of the job. Click on Yes.

above operations, you can select more than 
 the Shift and/or Ctrl keys on the 
ng the Torrent RIP

A preview of the job appears on-screen, for example:

The mouse cursor turns into a hand icon when it is placed 
over the image. You can use this to move the image around 
to view specific parts of it.

To view the whole job, select Reduced Roam from the 
Roam menu.
Note: The ‘Options’ dialog, available in the Roam menu, 
gives you more viewing options.

When you have finished previewing the job, close all open 
‘Roam’ windows.

Uncheck the Disable output box when you want Torrent to 
start outputting jobs again.

6.5.3  Re-printing, re
You can also use the O

• Re-print a job: d
the Active Queue.
is re-printed, high
button (refer to th
information about

• Change the orde
the required place
queue are printed

• Stop a job that i
from the top box 
Queue.

• Stop a page tha
from the Active Q

• Permanently rem
the job and click o
confirm the remo

Note: For most of the 
one file at a time using
keyboard.



27

6. Usi Cobra-8 User Guide

6.6
This
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Not
mak
man

WA
up t
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sho

6.6.
Befo
queu

1.

2.

6.6.
If yo
the 

1.

es of the available Torrent input queues 
t hand window along with any other 
ple:

ired input queue then close the Chooser.

int settings
s:

 make-up application and open or create a 

age Setup’ dialog, set the following options:

 should be On.

er Description, select Cobra 8-up.

m for the Paper Size and specify the 
 and Paper Height values, taking into 
dditional measurement for registration 
ng the Torrent RIP

 Printing a job to Torrent
 section gives you basic instructions for printing a job from a 
e make-up workstation to Torrent.

e: You should already know how to print a job in your page 
e-up application. Please consult the relevant application’s 
ual for more details about printing jobs.

RNING: Before you can print to Torrent you need to set 
he Cobra-8 print queue(s) on your page make-up 
kstation(s). This is covered in chapter 19 and you 
uld do this now if it has not been done already.

1  Making the Torrent input queues available
re printing to Torrent, you need to make Torrent’s input 
es available over the network. To do this:

In Torrent, select Start Inputs (so there is a tick by it) from 
the Torrent menu. While the input queues are being 
broadcast you will see the ‘Input Manager Dial’.

After a short time, the Torrent RIP is ready to receive jobs 
printed from across the network.

2  Selecting the printer (Mac Classic users only)
u are printing to Torrent from Mac Classic you need to select 
printer first:

On the Macintosh, open the Chooser. Click once on the 
LaserWriter icon in the top left-hand window, and then on 
EtherTalk in the ‘AppleTalk Zones’ window (the bottom-left 

window). The nam
appear in the righ
printers, for exam

2. Highlight the requ

6.6.3  Setting the pr
To set the print setting

1. Launch your page
job within it.

2. In the ‘Print’ or ‘P

• Separations

• For the Print

• Select Custo
Paper Width
account the a
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3.

6.6.
Whe
Setu

1.

2.

3.

6.7
Whe
read
Con
the 

 show you how to use the Cobra Console to 
 Cobra-8 platesetter and manage your jobs.

you how to set up the Cobra-8 platesetter 
late.
ng the Torrent RIP

marks (for example, Quark jobs typically add 11 mm all 
round).

WARNING: The paper width and height must 
include any extra measurement for registration 
marks, etc., otherwise the job will not output 
correctly.

• For the Printer, choose the name of the Torrent input 
queue.

Set all other options, as required.

4  Printing the job
n you have finished setting all the options on the ‘Page 
p’ or ‘Print’ dialog:

On the ‘Print’ dialog, click the Print or OK button to print the 
file to Torrent.

In Torrent, you will see a progress dialog as the job is being 
input.

Once the job has been input, each separation appears in the 
Output Controller’s Active Queue. As each separation is 
output as a TIFF file, it is moved to the Held Queue.

Note: Section 6.5 shows you how to use the Output 
Controller to preview and control the processing of your jobs 
in Torrent.

 When you have finished
n your jobs have been output as TIFF files by Torrent they are 
y for output to the Cobra-8 platesetter using the Cobra 
sole software. The job separations will automatically appear in 
relevant Cobra Console queue(s).

• Chapters 7 and 8
output jobs to the

• Chapter 9 shows 
for imaging the p
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6.8
Torr
used
mea

Not
8 sy

ager
 the ‘Device Manager’ dialog, which lets 
nd configure devices driven from a multiple 
r. This is equivalent to the Torrent > 
ager command.

s Manager
 the ‘Separations Manager’ dialog, which 
te and edit separation styles for the 
ice. This is equivalent to the Colour > 
s Manager command. (See the section 
, Screening & Colour” on page 60 for more 
)

p Manager
 the ‘Colour Setup Manager’ dialog box, 
 you to create and edit colour setups with 
olour management (depending on whether 
d-enabled ColourPro option is 
his is equivalent to the Colour > Colour 
ger command.

 Manager
 the ‘Calibration (Dot Gain) Manager’ 
 lets you create and edit calibration sets. 

alent to the Output > Calibration 
mmand. (See section 12.4 for more 
)

anager
 the ‘Cassette Manager’ dialog, which lets 
assettes and edit their information. This is 
 the Output > Cassette Manager 
ng the Torrent RIP

 Torrent’s toolbar
ent’s toolbar gives you quick access to the most frequently 
 menu options and dialog boxes. The toolbar buttons and their 
nings are shown below.

e: Not all of these buttons are required for use with the Cobra-
stem.

Print File
This displays the ‘Print File’ dialog, which lets you print 
a file. This is equivalent to the Torrent > Print File 
command.

Print Calibration
This displays the ‘Print Calibration’ dialog, which lets 
you print calibration targets for use in calibrating output 
devices. This is equivalent to the Output > Print 
Calibration command. (See section 12.3 for more 
information.)

Start Inputs 
This starts any enabled inputs. This is equivalent to the 
Torrent > Start Inputs command when the inputs are 
stopped. (See section 6.4.1 for more information.)

Stop Inputs
This stops any enabled inputs. This is equivalent to the 
Torrent > Start Inputs command when the inputs are 
started. (See section 6.4.2 for more information.)

Page Setup Manager
This displays the ‘Page Setup Manager’ dialog, which 
lets you create and edit page setups. This is equivalent 
to the Torrent > Page Setup Manager command. 
(See section 11.3 for more information.)

Device Man
This displays
you create a
device drive
Device Man

Separation
This displays
lets you crea
selected dev
Separation
“Separations
information.

Colour Setu
This displays
which allows
or without c
the passwor
activated).T
Setup Mana

Calibration
This displays
dialog, which
This is equiv
Manager co
information.

Cassette M
This displays
you create c
equivalent to
command.
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ng the Torrent RIP

Input Controller
This displays the ‘Input Controller’ dialog (or it hides the 
controller if it is already displayed). This is equivalent to 
the Torrent > Input Controller command. (See 
section 11.6 for more information.)

Media Manager
This displays the ‘Media Manager’ dialog, which lets you 
set up automatic media management. This is equivalent 
to the Output > Media Manager command.
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Not
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Console
 Cobra-8 workstation the Cobra Console 
:

e-launch the Cobra Console at any point, 
ms > HighWater Designs > Cobra 
ra Console. If the Cobra Console does not 
 back in to Windows using the username 
rd.

 in the previous dialog) is displayed when 
 launches. The ‘Current plate’ panel shows 
e) that is currently being processed/output 
 Cobra Console — Overview

 The Cobra Console — 
Overview

use the Cobra Console to output plates to the Cobra-8 
esetter, manage plate queues, view errored plates, and so on. 
 chapter gives an overview of the Cobra Console and it includes 
following sections:

7.1, The Cobra Console (p31).

7.2, The Pause/Resume button (p32).

7.3, The toolbar buttons (p32).

7.4, Plate search (p33).

7.5, Requeueing a plate using its barcode (p34).

7.6, The Tools button (p35).

7.7, Configuration options (p36).

7.8, Cobra Console Preferences (p38).

7.9, Previewing a plate (p39).

7.10, Removing the Torrent button from the Cobra Console 
(p39).

e: Using the Cobra Console for processing jobs and outputting 
 to the Cobra-8 platesetter is covered, in detail, in chapter 8.

7.1 The Cobra 
When you log in to the
launches automatically

Note: If you need to r
select Start > Progra
Console v1.x.x > Cob
launch, log off then log
Cobra with no passwo

The ‘Home’ tab (shown
the Cobra Console first
the plate (if there is on
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to th
next
pan

The 
butt

7.2

Cob

•

•

•

Click
proc

Not
the 
As w
Con
desc

r buttons
 six toolbar buttons along the top right of 

 button displays the Torrent RIP application 
ng). Using the Torrent RIP is covered in 
n chapters 6, 11 and 12.
 Torrent RIP is running on a separate 
to the Cobra-8 workstation, then this button 
nything. You can remove this button from 
nsole by following the instructions in 

.

for plate button lets you search for a 
ate. This is covered further in section 7.4.

 button lets you search for a plate using its 
his feature has been implemented). This is 
er in section 7.5.

Continued overleaf...
 Cobra Console — Overview

e Cobra-8 platesetter. The ‘Pending plates’ panel shows the 
 plates (up to three) that are waiting for output. These two 

els are discussed fully in the next chapter.

following sections describe the ‘Cobra Console’ window and the 
ons that are common to all tabs.

 The Pause/Resume button
The system Pause/Resume button in the top left-hand 
corner of the window controls the overall processing of 
the whole Cobra Console. It indicates the state of the 

ra Console:

Flashing grey — the system is starting up.

Flashing green/black — the Cobra Console is suspended. 
No processing is occurring (apart from any jobs that were 
being processed or were being output to the Cobra-8 
platesetter when the system was suspended).

Solid green — the Cobra Console is active and is processing 
jobs.

 on the Pause/Resume button to toggle the Cobra Console’s 
essing status between suspended and active.

es: It may take a short time for the system to change between 
active and suspended states.
ell as pausing/resuming processing of the whole Cobra 

sole, you can also suspend individual plates and queues. This is 
ribed further in chapter 8.

7.3 The toolba
The Cobra Console has
the window:

The Torrent
(if it is runni
more detail i
Note: If the
workstation 
will not do a
the Cobra Co
section 7.10

The Search 
processed pl

The barcode
barcode (if t
covered furth
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h
n  lets you search for a plate in any 

ch for plate button in the top right-hand 
ra Console.

ate’ dialog is displayed listing all plates that 
e system (that is, processing, pending, 
rored plates), for example:
 Cobra Console — Overview

7.4 Plate searc
The plate search butto
queue. To do this:

1. Click on the Sear
corner of the Cob

2. The ‘Search for pl
are currently in th
completed and er

The Tools button gives you access to:

• The Cobra Test Tool, which can help diagnose 
problems with the Cobra-8 system, let you check 
the laser power setting for your plates and save 
system settings. See chapters 15, 16 and 18 for 
further details.

• Configuration options for setting up the various 
Cobra-8 software applications and specifying their 
locations on disk. See section 7.6 for further 
details.

• Preferences, which let you specify email 
addresses for sending log files. See section 7.6 for 
further details.

Note: The Tools button is not available if the Cobra 
Console is processing jobs. You must first suspend 
processing using the Pause/Resume button.

The Help button opens this manual, the Cobra-8 User 
Guide, in Adobe Acrobat.

The Quit button quits out of the Cobra Console 
software.

Note: The Quit button is not available while the Cobra 
Console is processing jobs. You must first suspend 
processing using the Pause/Resume button and deal 
with any plate operation requested by the Cobra 
Console. Any jobs that are currently being processed or 
are being output to the Cobra-8 platesetter are 
completed before the Cobra Console quits.



34

7. The Cobra-8 User Guide

3.

4.

5.

g a plate using its barcode
e for output to the platesetter using its 
inted on the plate).

dix C for more information on setting up the 
 (BPR) application to add a barcode to your 

 barcode is held for 28 days since the plate 
 this time limit is exceeded, a ‘Cannot find a 
is identifier’ message is displayed when you 
late.

output using its barcode:

ole, click on the Barcode icon  in the 
rner of the window. The following dialog is 

rcode off the plate, or manually type in its 
umber (with or without hyphens).

ct format for the barcode is 12 digits (for 
000023, or three groups of 4 digits 
hens, for example, 0000-0000-0023).

s not typed in the correct format, as 
ou will see an ‘Invalid identifier’ message 
 OK.

utton.
 Cobra Console — Overview

To locate the required plate, simply type the plate name, or 
part of it, into the Name contains text box.
Notes: The search is not case-sensitive and is also carried 
out on the queue name (which is prepended to the plate 
name).
To clear the Name contains text box, click on the cross icon 

.

All the plate names containing the text you entered are 
displayed, along with their location, for example:

Select the required plate then click on the Go to plate 
button. You will be taken to the plate in its relevant queue.

7.5 Requeuein
You can requeue a plat
barcode (if one was pr

Notes: Refer to Appen
Barcode Plate Requeue
plates.
The record of a plate’s
was last output. When
completed plate with th
attempt to requeue a p

To requeue a plate for 

1. In the Cobra Cons
top right-hand co
displayed:

2. Either scan the ba
12-digit barcode n
Notes: The corre
example, 000000
separated by hyp

If the barcode wa
specified above, y
when you click on

3. Click on the OK b
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4.

7.6
The 
Con

•

•

•

sole to its suspended state (if necessary, 
e/Resume button  in the top left-
e window).

t plate output must be completed and the 
fore you can access the Tools button.

 button  in the top right-hand corner of 

isplayed:

ra Test Tool, click on the Cobra test tool 
ters 15, 16 and 18 for more details about 
ol.) You will see a ‘Suspending processing’ 
Cobra Test Tool launches.

figuration options or Preferences, type in 
y default, this is administrator) then click 
ton. The ‘Configuration’ and ‘Preferences’ 
 the window become active. These are 
ext two sections.
 Cobra Console — Overview

If the plate is found, the job will be moved back to its original 
queue, where it will be output to the Cobra-8 platesetter 
again, when that queue is active.

If the plate cannot be found, you will see the following 
message:

Click on OK to close the dialog.

 The Tools button
Tools button  in the top right-hand corner of the Cobra 
sole gives you access to:

The Cobra Test Tool, which can help diagnose problems with 
the Cobra-8 system, check the laser power setting for your 
plates and save system settings. See chapters 15, 16 and 18 
for more details about using the Cobra Test Tool.

Configuration options. These let you configure the various 
software applications (for example, Queue Configuration and 
Torrent) needed to run the Cobra-8 system. The configuration 
options also let you specify the paths to these applications. 
This is covered in section 7.7.

The Preferences let you specify email address(es) for 
sending log files and let you change the password for 
accessing the Configuration options. This is covered in 
section 7.8.

To access the tools:

1. Set the Cobra Con
click on the Paus
hand corner of th

Note: The curren
plate unloaded be

2. Click on the Tools
the window.

3. The following is d

• To launch the Cob
button. (See chap
the Cobra Test To
dialog before the 

• To access the Con
the Password (b
on the Log in but
tabs at the top of
described in the n
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7.7
The 
are 

To a

1.

You 

•

•

The 

•

nt RIP accepts incoming PostScript/PDF files 
 and interprets them into bitmap TIFF files 
t to the Cobra-8 platesetter.

1 and 12, and the Torrent User’s Guide 
ion about using the Torrent RIP.

bra-8 configurations, the Torrent RIP 
rate workstation to the Cobra-8 workstation.

ol
 Tool lets you create layout (ICF) files for 
a Console. Layout files contain the plate and 
ation that the Cobra Console needs when 

bs to the Cobra-8 platesetter (and also 
red for setting up InkMonitor if this 
alled with your Cobra-8 system).

r more information about the Cobra Layout 

equeue configuration
 Requeue (BPR) option adds a barcode to 
w you to quickly locate jobs for re-output.

nd Appendix C for more information about 

tor (LRG)
es ‘view’ files for use with the Cobra 

r more information about the Low Res 

 allows you to preview a plate. Refer to 
re information about using the Image 
 Cobra Console — Overview

 Configuration options
‘Configuration’ tab lists a number of software applications that 
used as part of the Cobra-8 system.

ccess the Configuration options:

Click on the Configuration tab. You will see a list of the 
Cobra-8-related software applications:

Note: If an application has a red button, the location of that 
application on disk is not defined. You can set this by 
following the instructions in section 7.7.2.

can use the ‘Configuration’ window to:

Launch these applications in order to configure the Cobra-8 
system (as described in section 7.7.1).

Set the paths to these applications (as described in 
section 7.7.2). You need to do this so that the Cobra Console 
knows where to find the required applications.

available applications are as follows:

Queue Configuration
You use this to create the Cobra Console queues. (See 
chapter 14, Appendix A and Appendix B for more information 
about creating queues using the Queue Configuration 
application.)

• Torrent RIP
HighWater’s Torre
from the network
suitable for outpu

See chapters 6, 1
for more informat

Note: In some Co
resides on a sepa

• Cobra Layout To
The Cobra Layout
use with the Cobr
job position inform
outputting your jo
information requi
application is inst

See chapter 13 fo
Tool.

• Barcode Plate R
The Barcode Plate
your plates to allo

See section 7.5 a
using BPR.

• Low-Res Genera
This creates low-r
Console.

See section 5.5 fo
Generator.

• Image viewer
The image viewer
section 7.9 for mo
viewer.
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•
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7.7.
To la
(exc
will 

1.

7.7.
The 
loca
new
it ca
indic
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1.

s displayed:

d application then click on the Open 

ation locations are:

iguration
v4.4\system\Editor.exe

0\HIGHWI.exe
rrent RIP may reside on a separate 
in which case you need to access it on that 

t Tool
ine v1.0.1\plotter.exe

te Requeue
v4.4\system\BPRConfig.exe

nerator
v4.4\System\LRGD.exe
 Cobra Console — Overview

HWRegister
This is used to enable the Cobra-8 software applications. (The 
installation engineer will already have done this.) 

Q2 Output Controller
This underlying application processes your jobs and outputs 
plates to the Cobra-8 platesetter.

1  Launching the software applications
unch the software applications listed on the ‘Configuration’ tab 
ept the Q2 Output Controller and Low-Res Generator, which 
not launch):

Click on the relevant button to launch that particular software 
application.

Note: If an application has a red button alongside it, that 
application’s location is not defined so the application will not 
launch. Set the location, as described in the next sub-section.

2  Specifying an application’s location on disk
‘Configuration’ tab allows you to specify an application’s 
tion on disk. You may need to do this if you have installed a 
 version of the software and you need to tell the system where 
n be found, or if an application has a red button alongside it 
ating that its application path is not set. 

pecify an application’s location on disk:

Hold the shift key down and click on the application’s button.

Note: If the application’s button is red, you do not need to 
hold the shift key down.

2. An ‘Open’ dialog i

3. Locate the require
button.

The default applic

• Queue Conf
D:\Cobra\Q2

• Torrent RIP
D:\TORR7.2r
Note: The To
workstation, 
machine.

• Cobra Layou
D:\Cobra\Eng

• Barcode Pla
D:\Cobra\Q2

• Low-Res Ge
D:\Cobra\Q2
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The 
have
to u

7.8
The 
send
Con

To s

1.

rences tab. The following window is 

ail address field, type the email 
e you would like error log files to be sent. If 
n one email address, separate them with a 
ample:
ater.co.uk;support@colorquest.co.uk

nge the password for accessing the Cobra 
n type the new password into the Enter 
ield and again into the Confirm new 

assword button.

password you set is not secure — that 
n unencrypted file in a human-readable 

ing the Cobra Console tools, click on the 
 button .
 Cobra Console — Overview

• Image viewer
D:\Cobra\Q2v4.4\HWViewer\HWViewer.exe

• HWRegister
D:\Cobra\Q2v4.4\security\HWRegister.exe

• Q2 Output Controller
D:\Cobra\Q2v4.4\system\controller.exe

next section describes how to set the Preferences. When you 
 finished using the Cobra Console tools, click on the Return 
ser mode button .

 Cobra Console Preferences
Cobra Console Preferences let you specify email addresses for 
ing log files and let you change the password for accessing the 

figuration options.

et the Preferences:

If you haven’t done so already, open the tools by following 
the instructions in section 7.6 and type in the password (the 
default is administrator).

2. Click on the Prefe
displayed:

3. In the Log file em
address(es) wher
there is more tha
semi-colon, for ex

support@highw

4. If you wish to cha
Console tools, the
new password f
password field. 

Click on the Set p

WARNING: Any 
is, it is held in a
format.

If you have finished us
Return to user mode
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7.9
All t
HWV

1.

2.

3.

 the Torrent button from 
ole
 in the top right of the Cobra Console 

orrent RIP application into the foreground 
n the Cobra-8 workstation). However, if the 
on a separate workstation, this button has 
 you can remove it from the Cobra Console, 

orkstation, open the Windows Explorer.
running the Cobra Console, you can do this 
lt and tab keys simultaneously, to display 
hen right-click in the Start menu and select 

xplorer window, navigate to 
 v1.x.x.

troller.ini file in Notepad.

 section starting:

p.path=D:\TORR7.2r0\HIGHWI.exe

p.path=

close the Notepad window.

o the Cobra-8 workstation and run the 
ill be no Torrent button.
 Cobra Console — Overview

 Previewing a plate
abs on the Cobra Console let you preview plates using the 
iewer application. To preview a plate with HWViewer:

Highlight a plate (either its preview or in a list):

Click on the Viewer button . The plate is opened in the 
HWViewer application, for example:

When you have finished, close the HWViewer window.

7.10 Removing
the Cobra Cons
The Torrent button 
window, switches the T
(if Torrent is installed o
Torrent RIP is running 
no effect, in which case
if desired. To do this: 

1. On the Cobra-8 w
Note: If you are 
by pressing the A
the Start menu, t
Explore.

2. In the Windows E
D:\Cobra\Console

3. Open the CCGCon

4. Scroll down to the
# The RIP.
application.ri

Change this to:
# The RIP.
application.ri

5. Save the file and 

When you next log in t
Cobra Console, there w
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8.
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•

•

•

•

8.1
The 
Con
bein
plat

Current plate’ and ‘Pending plates’ panel, as 
wo sections.

late’ panel
el in the top half of the window shows 
te that is currently being processed, the 
f the Cobra-8 platesetter (or any other 
rring), and a preview of the current plate, as 
ing sub-sections.

el

 panel displays the plate’s Name (which has 
nded to it), plus the Plate and Layout names 
ined in the Cobra Layout Tool), for example:
 Cobra Console tabs

 The Cobra Console tabs
 chapter describes the tabs available in the Cobra Console:

8.1, The ‘Home’ tab (p40).

8.2, The ‘Queue’ tab (p43).

8.3, The ‘Completed plates’ tab (p45).

8.4, The ‘Errored plates’ tab (p47).

 The ‘Home’ tab
Cobra Console’s ‘Home’ tab is displayed when the Cobra 
sole launches. The ‘Home’ tab shows the plate that is currently 
g processed/output to the Cobra-8 platesetter and the next 
es (up to three) that are queued for output, for example:

The ‘Home’ tab has a ‘
described in the next t

8.1.1 The ‘Current p
The ‘Current plate’ pan
information for the pla
operation and status o
processing that is occu
described in the follow

‘Plate information’ pan

The ‘Plate information’
the queue name prepe
(these names were def
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‘Ope

The 
plat

Lo

Clo

Busy...
The plate is currently being imaged.

Unload plate...
The plate has been imaged (or the plate 
was aborted). Remove the plate from 
Cobra-8’s drum.

Plate badly registered...
This error occurs if the plate becomes mis-
registered (after you have correctly 
registered it, but before the vacuum 
starts).

You will need to reload the plate: press the 
Load button on the register bar, pull the 
plate out from under the register bar, 
press the Load button again and then 
reclamp the plate.
 Cobra Console tabs

ration’ panel

‘Operation’ panel shows the current status of the Cobra-8 
esetter:

Idle
No jobs are ready for output, or the Cobra 
Console’s processing status has been set 
to suspended (indicated by a flashing 
green/black icon in the top left-hand 
corner of the window).

Load plate...
Cobra-8 is waiting for the user to load a 
plate into the drum (as described in 
section 9.4).

Close cover...
Cobra is waiting for its cover to be closed 
(after the plate has been successfully 
loaded into the drum).

ad plate...

se cover...

Busy...

Unload plate...

Plate badly registered...
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‘Pre

The 

lates’ panel
nel in the bottom half of the window shows 
three) in the queue that are waiting for 
platesetter, for example:

the queue name prepended to it), Plate and 
 defined in the Cobra Layout Tool) is shown 
ate in the queue.

re available:

Befo
A pr
be o
nex

 in viewer
s the highlighted plate in HWViewer. See 

 for more details about using HWViewer.

ueue
 is suspended click on the Activate button 

output to the Cobra-8 platesetter.

ueue
e is active, click on the Suspend button to 
te output to the Cobra-8 platesetter.
 Cobra Console tabs

view’ panel

‘Preview’ panel shows one of the following two images:

8.1.2 The ‘Pending p
The ‘Pending plates’ pa
the next plates (up to 
output to the Cobra-8 

The plate Name (with 
Layout information (as
for the first pending pl

The following buttons a

re imaging has started
eview of the plate that is to 
utput to the platesetter 

t.

During imaging
Once imaging has started, the 
‘Preview’ panel shows a preview 
of the job being imaged on the 
plate in the drum. The moving 
grey shaded area indicates how 
much of the plate has not yet 
been imaged (the grey bar 
clears from right to left).

Open plate
This display
section 7.4

Activate q
If the queue
to re-start 

Suspend q
If the queu
suspend pla
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8.2
The 
que
activ

Click
wind

 all the queues that have been created, for 

were created using the Queue Configuration 
d in chapter 14.

he ‘TicketMaker’ queues to the Imager 
hem to the platesetter.

e window, in the ‘Queue information’ panel, 
mation relating to the queue for example:

’ panel shows the following information:

ue name (as created in the Queue 
lication).

eue’s status—either suspended or active.

 current operation that the queue is 
it is idle).

o the right, lists all processing tasks that the 
all jobs in the queue.
 Cobra Console tabs

 The ‘Queue’ tab
‘Queue’ tab lets you view all the jobs that are waiting in the 
ues for processing. You can delete jobs, and suspend and 
ate individual jobs and queues.

 on the Queue tab  to display the ‘Queue overview’ 
ow:

The ‘Queue’ panel lists
example:

Notes: These queues 
application, as describe
Jobs are moved from t
queue, which outputs t

In the bottom half of th
you will see more infor

The ‘Queue information

• Name — the que
Configuration app

• Status — The qu

• Operation — The
performing (or if 

The ‘Operation’ panel t
queue will perform on 
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On t
avai
pop
list)

Click
exam

•

•

to view plate information, for example:

 panel shows the following information:

e name (with the queue name prepended to 

e plate definition as created in the Cobra 
e’ tab (see chapter 13 for more information 

 the layout name as created in the Cobra 
out’ tab (see chapter 13 for more 
 this).

ob (spot colours are shown in black).

re available for the highlighted plate(s) (or 
 a pop-up menu when you right-click on a 

e in viewer
s the plate in HWViewer. See section 7.4 
tails about using HWViewer.

 abort a plate that is currently being 
(the plate will be moved to the ‘Errored 
 See section 8.4 for more details about 
tes).
 Cobra Console tabs

he right-hand side of the window, the following buttons are 
lable for each queue (or the commands are available from a 
-up menu when you right-click on the queue name in the queue 
:

 on a queue name to view the plates in that queue, for 
ple:

The ‘Plate’ column shows the plate name (with the queue 
name prepended).

The ‘Status’ column shows the status of the plate (pending, 
completed or suspended).

Click on a plate name 

The ‘Plate information’

• Name — the plat
it).

• Plate — This is th
Layout Tool’s ‘Plat
about this).

• Layout — This is
Layout Tool’s ‘Lay
information about

• A preview of the j

The following buttons a
they are available from
plate name):

Activate queue
This activates a suspended queue (any jobs that have 
been individually suspended will stay suspended).
Note: Only one TicketMaker queue can be active at a 
time. Therefore, when you activate a TicketMaker 
queue, all other TicketMaker queues are automatically 
suspended. The Imager queue can be activated or 
suspended regardless of the other queues’ states.

Suspend queue
This suspends an active queue.

Open plat
This display
for more de

Abort
Use this to
processed 
plates’ tab.
errored pla
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Not
the 

leted plates’ tab
ompleted plates’ tab lets you view all the 
successfully processed. You can view, re-
s, as described in this section.

d plates tab  to display the following 
 Cobra Console tabs

e: For most actions, you can select more than one plate using 
Shift and/or Ctrl keys.

8.3 The ‘Comp
The Cobra Console’s ‘C
plates that have been 
queue and delete plate

Click on the Complete
window:

Activate
Use this button to activate a suspended plate.
Note: If the queue itself is suspended, the status of 
the plate changes to Pending.

Suspend
Use this button to suspend an active plate.

Move down
This moves the selected plate(s) down one place in the 
queue (plates at the top of the queue get processed 
first).

Move up
This moves the selected plate(s) up one place in the 
queue (plates at the top of the queue get processed 
first).

Move to top of queue
This moves the selected plate(s) to the top of the 
queue (plates at the top of the queue get processed 
first).

Move to queue...
This moves the plate to the specified queue (which you 
choose from a pop-up menu).

Delete
This deletes the selected plate(s). You will be asked to 
confirm the delete.
Note: Once deleted, a plate cannot be recovered.
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The 
for e

The 
com

Click
or c
que

To s
(eith
cros

to view its plate information, for example:

 panel displays the following information:

e image name (with the queue name 

e plate name as created in the Cobra Layout 
see section 13.5 for more information about 

 the layout name as created in the Cobra 
out’ tab (see section 13.4 for more 
 this).

late (spot colours are shown in black).
 Cobra Console tabs

‘Queue’ panel lists all of the queues that have been created, 
xample:

number in brackets before the queue name shows how many 
pleted jobs are in that queue.

 on the ALL entry to view the completed plates in all queues, 
lick on a specific queue name to view completed plates for that 
ue only, for example:

earch for a specific plate/plates, use the Name contains field 
er type all or part of the name into the text box). Use the 
s icon  to clear the text box.

Click on a plate name 

The ‘Plate information’

• Name — the plat
prepended to it).

• Plate — This is th
Tool’s ‘Plate’ tab (
this).

• Layout — This is
Layout Tool’s ‘Lay
information about

• A preview of the p



47

8. The Cobra-8 User Guide

The 
Not
you 

Not
than

8.4
The 
that
the 

lates tab to display the following window:

 all of the queues that are available, for 

s before the queue name shows how many 
at queue.

e to view the errored plates for that queue.
 Cobra Console tabs

following buttons are available for the highlighted plate(s):
e: These options are also available from a pop-up menu when 
right-click on a plate name.

e: For the Requeue and Delete actions you can select more 
 one plate using the Shift and/or Ctrl keys.

 The ‘Errored plates’ tab
Cobra Console’s ‘Errored plates’ tab lets you view all the plates 
 have terminated with an error. When an error has occurred, 
‘Errored plates’ tab icon will turn red:

Click on the Errored p

The ‘Queue’ panel lists
example:

The number in bracket
errored plates are in th

Click on the queue nam

Open plate in viewer
This displays the plate image in HWViewer. See 
section 7.4 for more details about using HWViewer.
Note: This button is not available if more than one 
plate is selected.

Requeue
This requeues the selected plates back to their original 
queue(s) for reprocessing.

Delete
This deletes the selected plate(s). You will be asked to 
confirm the delete.
Note: Once deleted, a plate cannot be recovered.
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To s
(eith
cros

Click

The 

•

•

•

•

•

•

•

re available for the highlighted plate(s):
re also available from a pop-up menu when 
te name.

e and Delete actions you can select more 
e Shift and/or Ctrl keys.

files
 log files to the email address(es) specified 
a Console’s Preferences (see section 7.6 for 
ls about this).
files record processing information and are 
etermining the cause of an error.

e in viewer
s the plate image in HWViewer. See 

 for more details about HWViewer.
 button is not available if more than one 
cted.

es the selected plates back to their original 
r reprocessing.

s the selected plate(s). You will be asked to 
 delete.

: A deleted plate is not retrievable in 
 Cobra Console tabs

earch for a specific plate/plates, use the Name contains field 
er type all or part of the name into the text box). Use the 
s icon  to clear the text box.

 on a plate name to view the plate’s information, for example:

‘Plate information’ panel displays the following information:

Name — the plate image name (with the queue name 
prepended to it).

Plate — This is the plate name as created in the Cobra Layout 
Tool’s ‘Plate’ tab (see section 13.5 for more information about 
this).

Layout — This is the layout name as created in the Cobra 
Layout Tool’s ‘Layout’ tab (see section 13.4 for more 
information about this).

Operation — This shows what processing stage the plate was 
at when the error occurred.

Error — This shows the error that occurred (for example, 
user aborted plate).

Reason — This shows the reason why the error occurred.

A preview of the plate (spot colours are shown in black).

The following buttons a
Note: These options a
you right-click on a pla

Note: For the Requeu
than one plate using th

Email log 
This emails
in the Cobr
more detai
Note: Log 
useful for d

Open plat
This display
section 7.4
Note: This
plate is sele

Requeue
This requeu
queue(s) fo

Delete
This delete
confirm the

WARNING
any way.
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te is the correct size for the job being output 
ould be between 510 x 400 mm minimum 
m maximum. See section 4.5 for more 
.

 register bar option
n purchased, there are two standard ‘U’ 

 levers on the register bar let you select the 
ion pins:

ister bar requires a round ‘U’ notch on the 
ate and a square notch on the right-hand 
ates must be punched to this format.

425mm) registration
istration:

locking wheels anti-clockwise until the 
he left.

ocking wheels.

Option 1 Option 2

425mm 425mm

780mm 830mm

Lever
king wheel
ting up the Cobra-8 platesetter for output

 Setting up the Cobra-8 
platesetter for output

 chapter shows you how to set up the Cobra-8 platesetter so 
 it is ready to image a plate. It includes the following sections:

9.1, Initial checks of the Cobra-8 platesetter (p49).

9.2, Setting the register bar option (p49).

9.3, Setting up the vacuum (p50).

9.4, Loading a plate into the Cobra-8 drum (p50).

9.5, Unloading the plate (p52).

9.6, If Cobra-8’s cover is opened during the imaging cycle 
(p53).

e: The Cobra-8 platesetter can optionally use sound alerts 
ng operation. Please refer to section 15.3 for details on setting 
sound alerts.

 Initial checks of the Cobra-8 
tesetter
re loading a plate into Cobra-8’s drum you should make the 
wing checks:

Ensure that there are no foreign objects on the Cobra-8 drum 
(pens, cups, paper, etc.).

Check that the Cobra-8’s drum and surrounding areas are 
free from dust and particles. Refer to section 16.1 for details 
on cleaning the drum.

WARNING: Anything left on the drum could damage the 
platesetter and/or the plate, and particles in the drum 
may contaminate plates.

• Make sure the pla
(the plate size sh
and 1080 x 850 m
plate information)

9.2 Setting the
Depending on the optio
notch registrations:

The locking wheels and
inner or outer registrat

Note: The Cobra-8 reg
left-hand side of the pl
side of the plate, so pl

To select the inner (
To select the inner reg

1. Slowly turn the 
levers move to t

2. Re-tighten the l

Inner registration

Outer registration

Loc
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Not
The 
Whe
sit f

late into the Cobra-8 drum

ndling plates, make sure that you 
ing procedures covered in chapter 3 
ng procedures in section .

 the plate
e into Cobra-8’s drum:

leave sheet from the plate.

s appropriate.

htroom’s yellow light or other safety lighting 
r.
that no-one enters the room while you are 
 plates. (See section 3.3.3 for more 

sole, make sure that the next job is ready 
t the Cobra Console is not suspended.

ver.

hannels correctly for the plate size, as 
on 9.3.

y the Cobra Console, load the plate, as 
ting up the Cobra-8 platesetter for output

elect the outer (780 or 830mm) registration
elect the outer registration:

. Loosen the locking wheels by turning them clockwise.

. Move the levers to the right and hold them there while you 
re-tighten the locking wheels.

 Setting up the vacuum
Cobra-8 platesetter holds the plate in place in the drum using 
cuum, which is applied to up to 26 channels across the drum. 
re imaging a plate, you must ensure that all the channels 
red by the plate are switched on and any uncovered channels 
switched off. You do this using the vacuum channel switches, 
h sit just above the register bar:

witch a vacuum channel on or off:

On: Rotate the vacuum channel switch from left to right 
(clockwise) to turn the channel on (as indicated by o on the 
switch).

Off: Rotate the vacuum channel switch from right to left 
(anti-clockwise) to turn the channel off (as indicated by x on 
the switch).

es: Rotate the switches by running your finger across them.
central 12 vacuum switches do not rotate.
n you have finished, make sure that all the channel switches 
lush with the Cobra-8 drum.

9.4 Loading a p

WARNING: When ha
follow the safe work
and the plate handli

9.4.1  Before loading
Before loading the plat

1. Remove the inter

2. Punch the plate, a

3. Switch on the brig
and close the doo
Note: Make sure 
loading/unloading
details.)

4. On the Cobra Con
for output and tha

5. Open Cobra-8’s co

6. Set the vacuum c
described in secti

7. When prompted b
described next.

Vacuum
switch
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9.4.
To lo

1.

2.

3.

4.

5.

 downwards pressure on the plate such that 
act with both registration pins and also with 
(as far as is possible whilst you are holding 
n be achieved with one hand located 
e top of the plate:

 in the correct position, the outer- or 
Ds (depending on the registration system 
d the plate clamping cycle will begin.

g cycle will clamp and release the plate 3 
cession (this ensures that the plate is sitting 
um) and the clamp will then close whilst the 
.

 starts, carefully release your grip of the 
ing the plate back against the drum surface 
nsure that plate is fully held against the 
he vacuum. A short period after the vacuum 
e clamp will open, as the vacuum is now 
firmly in position.

is process, the plate becomes mis-
mp will open automatically and the register 
the ‘Armed’ state.

e

Register bar
ting up the Cobra-8 platesetter for output

2  Loading the plate
ad a plate into Cobra-8’s drum:

‘Arm’ the register bar by pressing the Load button. All four 
LEDs will flash:

Hold the plate along its top edge (and also a side edge, if you 
wish).

Place the plate squarely into Cobra-8’s drum, while also 
flexing it to form a semi-cylindrical shape.

Rotate the plate anti-clockwise very slightly and slide the 
plate down such that the bottom left hand corner of the plate 
slides under the register bar and onto the left hand (round) 
registration pin, lighting the left hand registration LED.

Note: The entire surface of the right hand registration pin is 
contact sensitive, so it is important to ensure that the left 
hand notch of the plate is fully engaged onto the left hand 
registration pin before registering the right hand plate notch 
onto the right hand registration pin. Failure to ensure this 
could result in mis-registered plate output.

Maintaining your grip at the top of the plate and ensuring that 
the left hand notch of the plate remains in full contact with 
the left hand registration pin, slide the bottom right corner of 
the plate under the register bar and onto the right hand 
registration pin, lighting the right hand registration LED.

6. Maintain an even,
it remains in cont
the drum surface 
the plate), this ca
centrally along th

When the plate is
innermost two LE
used) will light an

The plate clampin
times in quick suc
flat against the dr
vacuum is applied

7. Once the vacuum
plate, lightly push
as you do so, to e
drum surface by t
is first applied, th
holding the plate 

Note: If during th
registered, the cla
bar will return to 

Load button Plat
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If you need to abandon the plate load, at any point, press the 
Load button on the register bar. This will switch off the 
vacuum. You can now pull the plate out from the register bar.

Check that both plate sides are fully vacuumed to the Cobra-8 
drum. If there is any gap between the drum and the plate (as 
shown below), unload the plate and then re-load it.

Plate loading is now complete.

Close Cobra-8’s cover. Cobra-8 will now start its imaging 
cycle. The Cobra Console shows the platesetter’s progress as 
it images the plate, as described in section 8.1.

.When Cobra-8 has finished imaging the plate, the Cobra 
Console will ask you to open the cover and remove the plate, 
as described in the next section.

 Unloading the plate
e the plate has been imaged, unload it as follows:

Make sure the plate will not be exposed to any light source 
that might fog it.

Open Cobra-8’s cover.

Carefully remove the plate from the drum.

4. Process the plate.

Plate not in 
contact with
drum
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9.6
im

WA
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If Co

1.

2.

3.

ll see a message on the Cobra Console 
oad the plate:

 and discard it.
ill be moved to the ‘Errored plates’ tab in 
, from where it can be requeued for re-
‘Errored Plates’ tab, locate the required 
 the ‘Requeue’ button .

inue with normal plate output.
ting up the Cobra-8 platesetter for output

 If Cobra-8’s cover is opened during the 
aging cycle

RNING: Unless there is an emergency, you should never 
n Cobra-8’s cover to stop job output. If you wish to 
rt the currently outputting job, then click the  button 
t to the Progress bar on the Cobra Console.

bra-8’s cover is opened during the imaging cycle:

Cobra-8’s carriage will stop moving immediately. If the laser 
is operating, it will switch off immediately so that you cannot 
be exposed to it.

On the Cobra Console you will be asked to close the Cobra-8 
platesetter’s cover:

When you have closed the cover, Cobra-8’s carriage will 
return to its default position (to the left-hand side of the 

drum) and you wi
asking you to unl

4. Remove the plate
Note: The plate w
the Cobra Console
output: go to the 
plate then click on

5. You can now cont

Close cover...

Unload plate...
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nts that make up a 

b output, from page make-up right through 
obra-8 platesetter, consists of processing 
 software applications and parameter files. 
hows how each of these elements makes up 

e job to a Torrent input queue from a 
e network.

ob and applies the settings specified in the 
up (resolution, page size, job rotation, etc.).

e job (as bitmap TIFF file separations) to 
cified in the Torrent page setup.

ole looks in this directory for jobs to 
es any job it finds there into the appropriate 

e processes jobs in the queues and then 
e Imager queue which outputs them to the 
er, using the parameters stored in the 
t file (created in the Cobra Layout Tool) and 
on (from the Queue Configuration 

 in bold above are the ‘elements’ that make 
eed to create these elements, as described 
rs.
erview of creating a new workflow

. Overview of creating a 
new workflow

n the Cobra-8 system was installed, the engineer set it up to 
 with your plates and other job settings. However, if you want 
troduce a new plate size or type, or change other settings, you 
 to create a new ‘workflow’ through the system — this 
flow gives the system all the information needed to correctly 

e, process and output jobs to the Cobra-8 platesetter.

 chapter includes the following sections:

10.1, When you need to create a new workflow (p54).

10.2, The elements that make up a workflow (p54).

10.3, Naming workflow elements (p56).

e: Chapters 11–14 show you how to create a new workflow.

.1 When you need to create a new 
rkflow
need to create a new workflow in your system when you 
duce either of the following:

A new plate size or type.

A new job position on the plate.

10.2 The eleme
workflow
The whole process of jo
to final output to the C
‘elements’ that include
The diagram overleaf s
the workflow:

• First, you print th
workstation on th

• Torrent RIPs the j
Torrent page set

• Torrent outputs th
the directory spe

• The Cobra-8 Cons
process, and plac
queue. 

The Cobra Consol
moves them to th
Cobra-8 platesett
associated Layou
queue informati
application).

Note: The items shown
up the workflow. You n
in the following chapte
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le gets the 

and other 
ls from the 
n application

Layout file
The Cobra Console gets the plate and 
job information from the appropriate 

Layout file (created in the Cobra 
Layout Tool)

Cobra Console

2

6

Plate image 
output
to Cobra-8

n Layout files from 
Cobra Layout Tool

ation

SM102.icf
SM74.icf
GTO46.icf
erview of creating a new workflow

Workflow elements

Torrent input queue
u print a job to the Torrent 
t queue from a page make-
workstation on the network

Torrent page setup
Jobs are processed by Torrent 
using the settings in the page 

setup

Bitmaps directory
The resulting TIFF bitmap files 
are placed in a sub-directory 
of K:\PLOTDATA\BITMAPS on 

the Cobra-8 workstation

Queue infor
The Cobra Conso

queue names 
processing detai

Queue Configuratio

Job printed 
from page 
make-up 
application

Page make-up 
workstation on the 

network

Torrent RIP
Page setups

SM102
SM74
GTO46

K:\PLOTDATA\BITMAPS\SM10

K:\PLOTDATA\BITMAPS\SM74

K:\PLOTDATA\BITMAPS\GTO4

Queue 
Configuratio

SM102
SM74
GTO46

Cobra-8 workst

TIFF 
files 

output 
from 

Torrent

Torrent
workstation
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.3 Naming workflow elements
re you create the new workflow, you should choose a common 
e for all the separate workflow elements. Giving all workflow 
ents the same name makes it easier to:

Create, edit and delete workflows.

Track jobs.

Track errors.

Maintain your system (for file deletion, etc.).

g the press name is the recommended way of naming your 
kflows, for example, SM102. However, the workflow name 
 need to be more specific: for example, if you have more than 
workflow for the same press. To avoid confusion, make sure 
name you choose clearly identifies the workflow. For example, 
names SM102_centred and SM102_default are more 
ningful than SM102_1 and SM102_2.
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ion. The sub-directory should have the same 
flow you are creating, for example, 
ITMAPS\SM102.

u have a two-computer Cobra-8 
ectory MUST be created on the Cobra-8 
t on the RIP workstation.

iliar with using the Torrent RIP. Chapter 6 
 of the Torrent RIP and the Torrent User’s 
etails on setting up and using the RIP.

s you how to set the Cobra-8-specific 
rrent page setup. For more information 
gs, such as trapping and colour 
ase refer to the Torrent User’s Guide 
umentation that was supplied with any 
lugins you are using).

 the Torrent RIP
 by clicking on the Torrent RIP icon  in 
er of the Cobra Console.

IP does not launch, then open it following 
ion 7.7.1.
g on the Cobra-8 workstation, launch it by 
rams > HighWater Designs > Torrent 
r similar.
eating a Torrent page setup and input queue

. Creating a Torrent page 
setup and input queue

first stage in creating a workflow is to create a page setup and 
t queue in the Torrent RIP. The page setup defines the settings 
olution, page size, etc.) to be applied to the jobs sent to 
ent. The input queue lets you print jobs to Torrent from across 
network.

 chapter shows you how to create a Torrent page setup and 
t queue, and it includes the following sections:

11.1, Before you begin (p57).

11.2, Launching the Torrent RIP (p57).

11.3, The Page Setup Manager (p58).

11.4, Creating a new page setup (p58).

11.5, Saving the page setup (p65).

11.6, Creating a new input queue (p66).

11.7, When you have finished (p67).

.1 Before you begin
re you start to work through this chapter please bear the 
wing points in mind:

Choose one unique name for the workflow, as discussed in 
section 10.3. You will use this name for both the page setup 
and input queue (and also for the Layout file and queue that 
you will create in the following chapters). In this example, we 
will call the new workflow SM102.

Before you create the new Torrent page setup, create the 
directory where the TIFF files are to be saved. This should be 
a sub-directory of K:\PLOTDATA\BITMAPS\[sub-dir] on the 

Cobra-8 workstat
name as the work
K:\PLOTDATA\B

WARNING: If yo
system, this dir
workstation, no

• You should be fam
gives an overview
Guide gives full d

• This chapter show
settings in the To
about other settin
management, ple
(and/or other doc
Torrent options/p

11.2 Launching
Launch the Torrent RIP
the top right-hand corn

Notes: If the Torrent R
the instructions in sect
If Torrent is not runnin
selecting Start > Prog
vx.x > Torrent x.x, o
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 copy a page setup that is similar to the one 
g.

tup’ dialog is displayed:

ns all the details of the page setup you 
 is divided into a number of panels, which 

ify the settings to be applied to your jobs. 
s is described in the following sections.
eating a Torrent page setup and input queue

.3 The Page Setup Manager
orrent, you create a page setup using the Page Setup Manager. 
isplay the Page Setup Manager:

If necessary, stop the input queues by selecting Start Inputs 
in the Torrent menu (so that it does not have a tick by it).

Either choose Page Setup Manager... from the Torrent 
menu, or click on the Page Setup Manager button on the 
toolbar. The following window is displayed:

The Page Setup Manager lists all the page setups that have 
been created. For each one, it shows the page setup’s name, 
output device, resolution, calibration and separations style.

Page Setup Manager lets you edit, create, copy and delete 
e setups. Creating a new page setup is described in the next 
ion.

.4 Creating a new page setup
quickest way to create a new page setup is to copy an existing 
and edit its details. To do this:

In the Page Setup Manager, highlight an existing page setup 
and click on the Copy... button.

Note: If possible,
you will be creatin

2. The ‘New Page Se

This dialog contai
copied. The dialog
allow you to spec
Each of the panel
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ht the K:\PLOTDATA\BITMAPS\[sub-
u created on the Cobra-8 workstation (as 

on 11.1) then click on OK. The location of 
ow shown alongside the ‘Folder’ button.
he new workflow directory you created, in 
102.

l other fields are set as shown in the 
nfiguration’ dialog:

ludes resolution box is unchecked.

eneration is set to Conventional.

e field is not required.

nal name generation’ panel:

set to TIFF.

name as stem box is checked.

Filenames box is unchecked.

e num prefix box is unchecked.

name unchanged box is unchecked. 

filenames box is checked.

to TIF.

mat’ panel:

t is set to Multiple strips.

 bit order box is unchecked.

2 bit alignment (monochrome only) box 
.

g is set to IBM PC.

n is set to CCITT Group 4.

g is set to None.

 any options in the ‘Post processing’ panel.
eating a Torrent page setup and input queue

tput Device

 ‘Output Device’ panel specifies where your output will be sent. 
use with the Cobra-8 system, the output will be to TIFF files. 
et this:

From the Device pull-down list, select TIFF.

Click on the Configure device... button to display the ‘TIFF 
Configuration’ dialog:

To tell Torrent where to output the TIFF files, click on the 
Folder button. The ‘Select Folder’ dialog is displayed.

Locate and highlig
dir] folder that yo
described in secti
the TIFF files is n
Note: sub-dir is t
this example, SM

4. Make sure that al
previous ‘TIFF Co

• The Path inc

• File name g

• The Templat

In the ‘Conventio

• The Stem is 

• The Use job

• The Use 8.3 

• The Del pag

• The Use job

• The Unique 

• Suffix is set 

In the ‘Output for

• TIFF Forma

• The Reverse

• The Pad to 3
is unchecked

• Byte orderin

• Compressio

• Anti-Aliasin

• Do not select
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 a separations style for use with Cobra-8 
nd click on the Select button. Otherwise, to 
rations style for use with Cobra-8, continue 
tions.

K Separations (Halftone) entry, then 
... button. The following dialog is displayed:

e for the separations style, for example, 
llipP 175 lpi.
eating a Torrent page setup and input queue

Click on OK to close the ‘TIFF Configuration’ dialog.

have now finished setting the TIFF options.

parations, Screening & Colour

use this panel to set the separations and screening options.

es: HighWater recommends the settings described in this 
ion. However, if you have different requirements, you may 
ge the settings, as appropriate.
only need to create a new separations style for Cobra-8 once 
ess you need to create additional separations styles) — it will 
 be available for all page setups.

et the separations and screening options:

Click on the Separations Manager button ( ) to display 
the following dialog:

2. If there is already
then highlight it a
create a new sepa
with these instruc

3. Highlight the CMY
click on the Copy

4. Type in a new nam
CMYK HT Seps E
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row’ box, select Yes from the first pull-down 
e the angle to 135:

yan, Magenta and Yellow angles at 15°, 
ctively.

de separations in job, Override angles 
eseparated jobs, and Recombine 
bs options, as required.

de dot shape in job box.

de frequency in job box.

 and Frequency list, scroll down to 2540 
ange the frequency to the required value 
d 200 lpi) in the ‘Edit selected row’ panel:

end that you do not set a frequency of 

ate extra grey levels box near the bottom 
 select 2048 from the Limit distinct 
levels to list.

rlequin Precision Screening box.
eating a Torrent page setup and input queue

Click on the Create button. The following dialog is displayed:

From the Dot shape pull-down menu, select EllipticalP.

In the top window, highlight the Black separation.

In the Edit selected row box, type 135 for the new angle:

If there are other colours in the job to be printed (other than 
CMY), highlight (Other Colours in job) in the top window. In 

the ‘Edit selected 
menu, and chang

Note: Leave the C
75° and 0°, respe

10.Select the Overri
in job, Reject pr
preseparated jo

11.Check the Overri

12.Check the Overri

13.In the Resolution
resolution and ch
(between 175 an

Note: We recomm
over 200 lpi.

14.Check the Gener
of the dialog, then
number of grey 

15.Check the Use Ha
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w separations style is highlighted, then click 
 to choose this style and return to the ‘New 
g.

must recalibrate the page setup after 
parations style settings. Please refer to 
ull details on calibration.

e Torrent User’s Guide for more details 
colour management options, if required.

pping option, if any.

he Torrent User’s Guide (or other supplied 
re information about trapping.
eating a Torrent page setup and input queue

.You have now finished creating the new separations style. 
The finished dialog should look similar to this:

.Click on OK to close the dialog. You will now see the new 
separations style in the Separations Manager:

18.Make sure the ne
the Select button
Page Setup’ dialo

WARNING: You 
changing the se
chapter 12 for f

Note: Refer to th
about setting the 

Trapping

Select the required tra

Note: Please refer to t
documentation) for mo
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n:

e Units pull-down list, then set the 
izontal resolution values to 2540.

erride resolution in job box is checked.

cessing options:

n and Exposure fields are not required.

re, check the Enable Feature box then 
om the pull-down menu. Refer to the 
uide for more information about using 
eating a Torrent page setup and input queue

libration & Dot Gain

 panel lets you set the calibration and dot gain settings. (You 
do this later. Continue with the instructions in this chapter first, 
 go to chapter 12 for instructions on how to calibrate the page 
p).

RNING: You MUST calibrate your Torrent page setups to 
ure quality of output.

ssette & Page

 panel is not required for use with the Cobra-8 system.

Resolution

To specify the resolutio

1. Select dpi from th
Vertical and Hor

2. Make sure the Ov

Processing

To set any required pro

1. The Optimisatio

2. To specify a featu
select a feature fr
Torrent User’s G
features.
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ptions:

ns... button at the bottom of the ‘New Page 
isplay the following dialog:

equired (refer to the Torrent User’s Guide 
ion about the available options).

nished, click on OK to close the ‘Page Setup 
eating a Torrent page setup and input queue

ects

 following effects are available:

Negative outputs the job in negative.

Mirrorprint produces a mirror image (reflected in the vertical 
axis).

The Control strip option is not suitable for use with the 
Cobra-8 system so do not select it.

You can Rotate the job by 0, 90, 180 or 270 degrees.

Trim page removes white space at the top and bottom of the 
job.

e: You can see the effects of selecting the Rotation, Negative 
 Mirrorprint options in the small page icon .

ling

et the scaling:

Set the Horizontal and Vertical scaling to 100%.

Options...
To set the page setup o

1. Click on the Optio
Setup’ dialog to d

2. Set the fields, as r
for more informat

3. When you have fi
Options’ dialog.



65

11. Cr Cobra-8 User Guide

PD
To s

1.

2.

3.

You 
cove

e page setup
d creating the new page setup, the dialog 
:

:

 As... button, type a name into the Save As 
 the Save button.
 give the page setup the same name as the 
mple, SM102.
eating a Torrent page setup and input queue

F Options...
et the PDF options:

Click on the PDF Options... button (at the bottom of the 
‘New Page Setup’ dialog) to display the following dialog:

Set the fields, as required (refer to the Torrent User’s Guide 
for more information about the available options).

When you have finished, click on OK to return to the ‘New 
Page Setup’ dialog.

have now finished creating the page setup. Saving it is 
red in the next section.

11.5 Saving th
When you have finishe
will look similar to this

To save the page setup

1. Click on the Save
box, then click on
Note: You should
workflow, for exa
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2.

3.

Now
with
pag

 new input queue
ue for the page setup you have just created:

troller... from the Torrent menu to display 
ller’:

 button. The ‘Input Channel Edit’ dialog is 

etup you have just created from the pull-

or the new input queue (this should be the 
tup name, for example, SM102).

 from the Type pull-down list.
le to send jobs to Torrent other than via 
refer to the Torrent User’s Guide for 
out this.
eating a Torrent page setup and input queue

The page setup you have just created appears in the ‘Page 
Setup Manager’, for example:

Click on OK to close this window.

WARNING: Make sure that you close the ‘Page Setup 
Manager’ by clicking the OK button, otherwise any 
changes you have made to the page setups will be lost.

 that you have created a page setup, you need to associate it 
 an input queue, which will allow you to send jobs from your 
e make-up workstation to Torrent. This is covered next.

11.6 Creating a
To create an input que

1. Select Input Con
the ‘Input Contro

2. Click on the New
displayed:

3. Select the Page S
down list.

4. Type in a Name f
workflow/page se

5. Select AppleTalk
Note: It is possib
AppleTalk. Please 
further details ab
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6.

7.

8.

 have finished
shed creating a new Torrent page setup and 
 to run through the test and calibration 
ed below.

orrent page setup and input queue
nt page setup and input queue you have 
operly:

e so already, copy the appropriate Cobra-8 
ion you are printing from and create a 
ue (chapter 19 shows you how to do this).

ue and page setup by printing a job from 
 workstation (see section 6.6 for 

inting a job to Torrent).

IP’s Roam feature to check that the job has 
ee section 6.5.2 for more information about 

FF bitmap separations are in the correct 
n the Cobra-8 workstation 
TMAPS\[sub-dir]).

d that the new input queue and page setup 
ou can create a Layout file to associate with 
. This is covered in chapter 13.

e page setup
 Torrent you must also calibrate the Torrent 
ed next in chapter 12.

t go through the calibration procedure 
12 before you produce output for 
test purposes.
eating a Torrent page setup and input queue

Make sure the Enabled box is checked:

Note: If you do not set Enabled, the input queue will be 
marked Off in the Input Controller, and you will not see it on 
any workstations after you have broadcast your input queues.

Click on OK to close the ‘Input Channel Edit’ dialog. In the 
‘Input Controller’ you will see the input queue you have just 
created:

Close the ‘Input Controller’ window.

11.7 When you
Now that you have fini
input queue, you need
procedures, as describ

11.7.1  Testing the T
To check that the Torre
created are working pr

1. If you haven’t don
PPD to a workstat
Cobra-8 print que

2. Test the input que
the page make-up
instructions on pr

3. Use the Torrent R
output correctly (s
this).

4. Check that the TI
output directory o
(K:\PLOTDATA\BI

When you have checke
are working properly y
a Cobra Console queue

11.7.2  Calibrating th
Before printing jobs to
page setup, as describ

WARNING: You mus
described in chapter
anything other than 



68

12. Ca Cobra-8 User Guide

12

Ever
Cob
it ou
setu

•

•

•

•

•

•

Not
info

WA
des
any

12
Befo

•

•

•

ion to calibration
d to be created for each Torrent page setup 
ration process is summarized below and 
ns are included in the following sections.

d Torrent page setup and print out an 
et’ on the Cobra-8 platesetter.

er to read the densities off the plate.

bration Manager to create new calibration 
ge setup. Enter the values from the 

 save them.

etup again, attach the new calibration 
save it.

rated target to check the new settings and 
ion, if necessary.

gineer who installed your Cobra-8 system 
age setups that were initially created, you 
ation from time to time. You will also need 
ge setups you create.
librating Torrent page setups

. Calibrating Torrent page 
setups

y Torrent page setup needs to be calibrated to ensure that the 
ra-8 platesetter produces the correct dot densities for the jobs 
tputs. This chapter describes how to calibrate a Torrent page 
p and includes the following sections:

12.1, Before you begin (p68).

12.2, Introduction to calibration (p68).

12.3, Printing an uncalibrated target (p69).

12.4, Using the Calibration Manager (p69).

12.5, Refining the calibration (p72).

12.6, Re-calibrating a page setup (p73).

e: Also refer to the Torrent User’s Guide for more 
rmation about calibrating page setups.

RNING: You must go through the calibration procedure 
cribed in this chapter before you produce output for 
thing other than test purposes.

.1 Before you begin
re you start working through this chapter, make sure that:

You have created all the required page setups.

You have a suitable plate densitometer.

You have suitable plates and a processor.

12.2 Introduct
Calibration settings nee
that you use. The calib
step-by-step instructio

1. Select the require
uncalibrated ‘targ

2. Use a densitomet

3. Use Torrent’s Cali
settings for the pa
densitometer and

4. Select the page s
settings to it and 

5. Print out the calib
refine the calibrat

Note: Although the en
calibrated the Torrent p
should check the calibr
to calibrate any new pa
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The 
targ

1.

2.

3.

4.

5.

6.

 Calibration Manager
the test strip to plate and read the values, 
 calibration settings in the Calibration 

p Manager... from the Torrent menu to 
tup Manager.

etup you are calibrating and click on the 
pen the ‘Edit Page Setup [name]’ dialog.

 & Dot Gain’ panel, click on the Calibration 
ger button:

ot Gain) Manager’ dialog is displayed:

any calibration sets that have already been 

Calibration (Dot Gain) Manager 
button
librating Torrent page setups

.3 Printing an uncalibrated target
first step in calibrating a page setup is to print an uncalibrated 
et. To do this:

In Torrent, deselect Start Inputs... on the Torrent menu (so 
there is no tick by it).

Select Print Calibration from the Output menu to display 
the following dialog:

From the Print for pull-down menu, select Monochrome 
only.

Select the page setup you wish to calibrate from the list in the 
From Page Setup(s): column.

Click on the Print uncalibrated target button. This 
produces a test strip which you should output to the Cobra-8 
platesetter.

When you have output the job to plate and processed it, use 
an appropriate densitometer to measure the values on the 
test strip. Make a note of the values you measure.

12.4 Using the
Once you have output 
you need to create new
Manager. To do this:

1. Select Page Setu
open the Page Se

2. Select the page s
Edit... button to o

3. In the ‘Calibration
(Dot Gain) Mana

4. The ‘Calibration (D

This window lists 
created.
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5.

6.

7.

8.

9.

ou can enter a range for the Screen freq., 
lect the appropriate units of measurement. 

re box unchecked. 

e for Pos & Neg box is unchecked. This is 
bra-8 software.

riate value from the Measurements as 
depending on the type of densitometer you 

olors box should be left unchecked.

ed 0.0 to 100.0 type in the values that you 
ur test strip.
librating Torrent page setups

From the Device pull-down menu at the top of the dialog, 
select TIFF.

From the Colour pull-down menu, select Monochrome.

Click on New... to display the ‘Edit uncalibrated target for 
TIFF’ dialog:

In the Name field, give the calibration set a name based on 
the one for the page setup/workflow (for example, SM102).

In the ‘Warning Criteria’ panel, enter values for Resolution, 
Dot shape and Screen Freq that match those of the page 
setup you are calibrating (typically, 2540 dpi, EllipticalP and 
175 to 200 lpi, respectively).

Note: The calibration is normally valid for all screen 

frequencies, but y
if required, and se

10.Leave the Exposu

11.Make sure the Us
handled by the Co

12.Select the approp
pull-down menu, 
are using.

13.The Force solid c

14.In the boxes mark
measured from yo
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 (Dot Gain) Manager’, make sure the new 
ighlighted, and click on Select.

to the ‘Edit Page Setup [name]’ dialog. The 
t is now displayed in the Calibration field:

urn to the Page Setup Manager, and on OK 

e sure that you close the ‘Page Setup 
king the OK button, otherwise any 
ve made to the page setups will be lost.
librating Torrent page setups

.When you have finished, the dialog will look similar to this:

.Click on OK to save the calibration settings.

17.In the ‘Calibration
calibration set is h

18.You are returned 
new calibration se

19.Click on OK to ret
to exit it.

WARNING: Mak
Manager’ by clic
changes you ha
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mor
furth

1.

2.

3.

4.

5.

alues compare acceptably with the test strip 
rther action is required. However, if the 
are significantly different, continue with the 
 rest of this section.

p Manager... from the Torrent menu to 
tup Manager’.

etup you are calibrating and click on the 
pen the ‘Edit Page Setup [name]’ dialog.

 & Dot Gain’ panel, click on the Calibration 
ger button. The ‘Calibration (Dot Gain) 
yed.

pull-down menu at the top of the dialog, 

pull-down menu, select Monochrome.

ired calibration and click on the Edit from 
t... button.

ed 0.0 to 100.0 type in the values that you 
ur test strip.

nished, click on OK to save the calibration 

 (Dot Gain) Manager’, make sure that the 
ighlighted, and click on Select.

to the ‘Edit Page Setup [name]’ dialog.

urn to the ‘Page Setup Manager’ and on OK 

e sure that you close the ‘Page Setup 
king the OK button, otherwise any 
ve made to the page setups will be lost.
librating Torrent page setups

.5 Refining the calibration
ecommend that you repeat the calibration process at least one 
e time to check that the calibration is correct and to provide 
er refinement to it. To do this:

In Torrent, select Print Calibration... from the Output 
menu to display the following dialog:

Select the required page setup from the From Page 
Setup(s): column.
Note: This is the same page setup that you used in the 
previous section.

From the Print for pull-down menu, select Monochrome 
only.

Click on the Print calibrated target button. This produces a 
test strip which you should output to Cobra-8.

When you have output the job to plate and processed it, use 
an appropriate densitometer to measure the values on the 
test strip. Make a note of the values you measure.

6. If the measured v
values then no fu
measured values 
instructions in the

7. Select Page Setu
open the ‘Page Se

8. Select the page s
Edit... button to o

9. In the ‘Calibration
(Dot Gain) Mana
Manager’ is displa

10.From the Device 
select TIFF.

11.From the Colour 

12.Highlight the requ
calibrated targe

13.In the boxes mark
measured from yo

14.When you have fi
settings.

15.In the ‘Calibration
calibration set is h

16.You are returned 

17.Click on OK to ret
to exit it.

WARNING: Mak
Manager’ by clic
changes you ha
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3.

4.

5.

6.

7.

8.

9.

10

nished, click on OK to save the calibration 

 (Dot Gain) Manager’, make sure that the 
ighlighted, and click on Select.

to the ‘Edit Page Setup [name]’ dialog.

urn to the ‘Page Setup Manager’ and on OK 

e sure that you close the ‘Page Setup 
king the OK button, otherwise any 
ve made to the page setups will be lost.

ration... from the Output menu.

d page setup from the Page Setup(s): 

r pull-down menu, select Monochrome 

 calibrated target button. This produces a 
ou should output to Cobra-8.

utput the job to plate and processed it, use 
nsitometer to measure the values on the 
 note of the values you measure.

d with the values, then the re-calibration 
te.

isfied with the values, then refine this 
 by following the instructions in section 12.5 
librating Torrent page setups

.6 Re-calibrating a page setup
may need to re-calibrate a page setup when, for example, you 
ge inks, processing chemicals or toner, or you change the 

er stock. If the page setup has not been changed and you are 
g its existing calibration set, the process is straightforward:

In Torrent, select Print Calibration... from the Output 
menu.

Select the required page setup from the From Page 
Setup(s): column.

From the Print for pull-down menu, select Monochrome 
only.

Click on the Print calibrated target button. This produces a 
test strip which you should output to Cobra-8.
Note: If preferred, you can print out the original, uncalibrated 
job. Click on the Print uncalibrated target button.

When you have output the job to plate and processed it, use 
an appropriate densitometer to measure the values on the 
test strip. Make a note of the values you measure.

If the measured values are significantly different, select 
Calibration Manager... from the Output menu to display 
the ‘Calibration (Dot Gain) Manager’.

From the Device pull-down menu at the top of the dialog 
select TIFF.

From the Colour pull-down menu, select Monochrome.

Highlight the required calibration and click on the Edit from 
calibrated target... button.
Note: If you printed the uncalibrated target, click on the Edit 
from uncalibrated target button.

.In the boxes marked 0.0 to 100.0 type in the values that you 
measured from your test strip.

11.When you have fi
settings.

12.In the ‘Calibration
calibration set is h

13.You are returned 

14.Click on OK to ret
to exit it.

WARNING: Mak
Manager’ by clic
changes you ha

15.Select Print calib

16.Select the require
column.

17.From the Print fo
only.

18.Click on the Print
test strip, which y

19.When you have o
an appropriate de
test strip. Make a

20.If you are satisfie
process is comple

If you are not sat
calibration further
again.
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e Preferences
he Cobra Layout Tool that you are creating a 

rences tab to display the following:

onitor software is installed on your system, 
 tabs on this dialog:
eating a Layout file

. Creating a Layout file
r creating the Torrent page setup and input queue you need to 
te a Layout file (also known as an Imager Configuration File, or 
file) using the Cobra Layout Tool. Layout files contain the plate 
 job position information that the Cobra Console needs when 
utting your jobs to the Cobra-8 platesetter (and also 

rmation required for InkMonitor, if you are using this 
ication with your Cobra-8 system).

 chapter includes the following sections:

13.1, Before you begin (p74).

13.2, Launching the Cobra Layout Tool (p74).

13.3, Setting the Preferences (p74).

13.4, Creating a new layout (p75).

13.5, Selecting a plate (p77).

13.6, Creating a new plate definition (p78).

13.7, Saving the Layout file (p79).

.1 Before you begin
re you create a new Layout file, you need to determine the 
ect laser power for the plate that will be used. This is covered 
apter 18 and you should do this now if you have not done so 

ady.

.2 Launching the Cobra Layout Tool
ch the Cobra Layout Tool, as described in section 7.7.

13.3 Setting th
First, you need to tell t
Layout file. To do this:

1. Click on the Prefe

Note: If the InkM
you will see extra
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2.

3.

4.

5.

 new layout
‘Layout’ pane to create a new layout, which 
f the job on the plate and other settings. To 

ut tab to display the following pane:

or is installed on your system, the Cobra 
ave extra tabs and options, as described in 
eating a Layout file

In the ‘Application Setup’ panel, click on the Layout editor 
radio button.

Check the Front of bed at bottom of screen box.

In the ‘Choice of Units’ panel, select either Metric to display 
measurements in millimetres, or Imperial to display 
measurements in inches.

Click on the Apply button to apply any changes.

13.4 Creating a
Next, you will use the 
specifies the position o
do this:

1. Click on the Layo

Note: If InkMonit
Layout Tool will h
step 4 below.
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2.

3.

4.

5.

ap’ setting specifies the amount of space 
 or left edge of the plate and the image. Set 
 gap (you cannot set both), as required.

n image right up to the edges of the plate in 
w-scan) direction so it is not absolutely 
 horizontal gap.

 setting specifies the amount of space 
r bottom edge of the plate and the image. 

Back gap (you cannot set both), as 

t gap must take into account the part of the 
ageable — typically, 15 mm. The installation 
 you this value.

Right gap

Job

Front gap

Back gap

ob
eating a Layout file

Click on the Add... button and type in a new name for the 
layout (this should be the workflow name, for example, 
SM102) then click on OK.

In the ‘Information’ panel, click on the Centre horizontal 
and/or Centre vertical boxes, if required.

InkMonitor users only:

• Check the Ink coverage box if you want to generate ink 
duct settings.

• Do not check the Output plate box.

All users: Right-click the mouse in the white plate layout 
area and select Plate Borders... from the pop-up menu. The 
following dialog appears:

6. The ‘Horizontal G
between the right
the Right or Left

Note: Cobra-8 ca
the horizontal (slo
necessary to set a

7. The ‘Vertical Gap’
between the top o
Set the Front or 
required.

Notes: The Fron
plate that is unim
engineer will give

Left gap

J
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8.

9.

a plate
is layout:

 tab to display the ‘Plate’ pane:

d Plate Name from the pull-down list.

 you require isn’t listed, you need to create 
ction 13.6 for details on how to do this.
eating a Layout file

It is not possible to image over the section of plate under the 
register bar, so the front gap cannot be set smaller than the 
minimum (typically, 15 mm).

Example: If you set a Right gap of 50 mm and a Front gap 
of 15 mm, the image will be positioned thus on the plate:

Note: The plate borders settings are applied in addition to the 
Centre horizontal and Centre vertical settings to give you 
more flexibility when positioning the image on the plate.

When you have finished, click on OK to close the ‘Plate 
Borders’ dialog.

On the ‘Layout’ pane, click on the Apply button.

13.5 Selecting 
To select a plate for th

1. Click on the Plate

2. Select the require

Note: If the plate
a new one. See se

50 mm
Right gap

15 mm
Front gap

P
la

te
 e

d
g
e

Job
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3.

4.

You 
save
show
do t

 new plate definition
efinition:

g a new plate definition to go with an 
en first select the required layout from the 

 tab to display the following dialog:

or is installed with your Cobra-8 system, the 
l will have extra tabs.

.. button, type a new name for the plate 

t and Width of the plate.

ness of the plate (usually 0.3 or 0.15 mm).
eating a Layout file

InkMonitor users only: On the ‘Plate’ pane, you also need 
to select an ink coverage or PPF configuration file. Click on the 
Browse... button to locate and select the required file:

Note: Please refer to the InkMonitor User’s Guide for more 
information about creating and using configuration files.

All users: Click on the Apply button.

have now finished creating a new layout. Next you need to 
 it as a Layout file, as described in section 13.7. (Section 13.6 
s you how to create a new plate definition, should you need to 

his).

13.6 Creating a
To create a new plate d

1. If you are creatin
existing layout, th
Layout tab.

2. Click on the Plate

Note: If InkMonit
Cobra Layout Too

3. Click on the Add.
then click on OK.

4. Type in the Heigh

5. Type in the Thick



79

13. Cr Cobra-8 User Guide

6.

7.

8.

You 

13
Whe
save

1.

2.

3.

4.

5.

Whe
Con
file.

Not
file,
desc
eating a Layout file

Select Positive or Negative for the plate Type.

Type in a value for the Laser power.
Note: Instructions for determining the laser power can be 
found in chapter 18.

When you have finished, click on the Apply button to apply 
the changes.
Note: The plate you select here will be applied to the 
currently selected layout on the Layout tab. Therefore, make 
sure that you select the correct plate for the currently 
selected layout, then click on the Apply button.

have now finished creating a new plate definition.

.7 Saving the Layout file
n you have selected the required plate and layout you need to 
 the information as a Layout file. To do this:

Click on the Layout tab and check that the settings are 
correct.

Click on the Save button to display the ‘Save As’ dialog.

If necessary, navigate to the default ICF directory (usually 
D:\Cobra\Engine v1.0.1), then type a name for the Layout file 
(this should be the workflow name, for example, SM102.icf).

Click on the Save button. The Layout file is saved.

When you have finished using the Cobra Layout Tool, quit out 
of it by clicking the Exit button.

n you create the new Cobra Console queue (using the Queue 
figuration application), you will associate it with this Layout 
 This is covered in the next chapter.

e: If you have created a new layout, plate definition or Layout 
 we recommend that you save this new information, as 
ribed in section 16.2.
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ew of creating a new queue
figuration application to create a new Cobra 
h queue you will specify the following 

t combination of these settings requires a 
ed.

The queue’s name (the new queue will 
have the workflow name).

Where the Cobra Console looks for jobs to 
process. This is the directory where the 
Torrent RIP saves the bitmap TIFF files.

This specifies where the job’s thumbnail 
images can be found.

These specify settings such as the job’s 
priority.

This specifies which application(s) should 
process your jobs.

This specifies the Layout file (created in 
the previous chapter), which contains 
information about the plate size, job 
position, etc.

These options specify what happens to the 
job after it has been processed.

These settings ensure that only one job 
can be output to the Cobra-8 platesetter at 
a time.
eating a TicketMaker queue

. Creating a TicketMaker 
queue

final stage of creating the new workflow is to create a 
etMaker queue. You do this using the Queue Configuration 
lication, as described in this chapter.

 chapter includes the following sections:

14.1, Before you begin (p80).

14.2, An overview of creating a new queue (p80).

14.3, Launching the Queue Configuration application (p81).

14.4, Creating a new queue (p81).

14.5, The finished queue (p89).

14.6, Checking the new queue (p89).

14.7, Other Queue Configuration options (p90).

14.8, Setting the preferences (p91).

e: This chapter also includes instructions for setting up an 
onitor queue.

.1 Before you begin
re you follow the instructions in this chapter:

Create the required Layout file(s) using the Cobra Layout Tool 
(refer to chapter 13 for instructions).

Make sure that the Imager and Completed queues have 
already been created, as described in appendices A and B.

14.2 An overvi
You use the Queue Con
Console queue. For eac
information:

Each workflow/differen
new queue to be creat

Name

Inputs

Thumbnail images

Job settings

Processes to run

Process
instructions

Clean-up

Resource
management
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14
ap
To la

1.

2.

 new queue
:

figuration window, click on the Add button.

log appears:
eating a TicketMaker queue

.3 Launching the Queue Configuration 
plication
unch the Queue Configuration application:

Follow the instructions in section 7.7.1.

The ‘Queue Configuration’ window opens:

This window lists all the queues that you see in the Cobra 
Console (as well as the ‘Completed’ queue, which forms the 
Completed tab in the Cobra Console).

WARNING: If there are no ‘Imager’ and ‘Completed’ 
queues then you must create these now before you 
create any TicketMaker queues. Appendices A and B 
show you how to do this.
Do not delete the ‘Imager’ or ‘Completed’ queues.

14.4 Creating a
To create a new queue

1. In the Queue Con

2. The ‘Overview’ dia
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ctory is K:\PLOTDATA\BITMAPS\sub-dir, where 
me of the sub-directory where the high-res 
 Torrent RIP are saved. (The sub-directory 
ame as the workflow name, for example, 

ll pathname of this directory into the Path 
he Browse... button to display the ‘Queue 
log:

ht the required directory then click on OK.

log, check that the correct directory name is 

nished, click on OK to return to the 

ges

ates job thumbnail images for display in the 
tion 5.5 for more details about the LRG 
eating a TicketMaker queue

The ‘Overview’ dialog lets you view and edit the queue’s 
settings. The following sub-sections show you how to set each 
option in the ‘Overview’ dialog.

me

e Name field, type in the workflow name for the new queue 
example, SM102).

uts

‘Inputs’ panel specifies the directory where the Cobra Console 
ld look for files to be processed. This is the directory that 
s the TIFF files coming from the Torrent RIP. 

e: Each queue must have a unique input directory.

pecify the directory:

Click on the Change... button to display the following dialog:

2. The required dire
‘sub-dir’ is the na
TIFF files from the
should have the s
SM102.)

Either type the fu
field, or click on t
Hot Directory’ dia

Locate and highlig

3. In the ‘Inputs’ dia
shown.

4. When you have fi
‘Overview’ dialog.

Thumbnail Ima

The LRG application cre
Cobra Console (see sec
application).
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To s
1.

2.

3.

Job

The 
Thes

ge... button. The following dialog is 

ings’ panel, set the following options:

ber of copies to 1.

l priority to Normal.

l state of all jobs arriving in the queue to 
eating a TicketMaker queue

pecify the location of the thumbnail images:
Click on the Change... button. The following dialog appears:

Note: The Thumbnail Images directory is located at 
K:\PLOTDATA\VIEW\sub-dir, where ‘sub-dir’ is the name of 
the sub-directory where the high-res TIFF files from the 
Torrent RIP are saved (the directory should be the workflow 
name, for example, SM102).

Click on the Browse... button, locate the required directory, 
then click on OK.

When you have finished, click on OK to close the ‘Thumbnail 
Image Directory’ dialog.

 Settings

‘Job Settings’ let you specify options such as the job’s priority. 
e settings will be applied to all jobs in the queue. To specify 

the job settings:

1. Click on the Chan
displayed:

2. In the ‘Initial sett

• Set the Num

• Set the Initia

• Set the Initia
Suspended.
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3.

4.

5.

6.

Pro
Not
“Pro
to s

panel specifies which application(s) will 
se, the TicketMaker application. To set this:

to run’ panel, click on the Change... button 
owing dialog:

 options in the ‘Process Control’ panel.
eating a TicketMaker queue

• Check the Display thumbnails for all jobs as they 
arrive in the queue box. This option displays a 
thumbnail image of all jobs arriving in the queue (but 
only if the Low Res Generator has created them and a 
thumbnail directory has been specified).

• Do not select the Only display thumbnail image when 
job is active option.

• Do not select the Hide this queue... option.

In the ‘During Processing’ panel, select the Don’t process 
files while they are open with write access option.

Make sure the ‘Multi-Job Settings’ option is set to Process 
jobs individually.

In the ‘File Filtering’ panel, select the Exclude option and 
type .tmp, .db into the Filter Extensions box:

When you have finished, click on OK to return to the 
‘Overview’ dialog.

cesses to run
e: If you are an InkMonitor user, go to the next sub-section 
cesses to run (InkMonitor users only)” for instructions on how 
et the options in this panel.

The ‘Processes to run’ 
process jobs; in this ca

1. In the ‘Processes 
to display the foll

2. Do not select any
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3.

4.

5.

6.

7.

8.

Not
que
once

Pro

The 
proc
app

aker applications. To set this up:

to run’ panel, click on the Change... button 
owing dialog:

tions in the ‘Process Control’ panel.
eating a TicketMaker queue

The Path field should specify the TicketMaker.exe 
application (this file can be found at D:\Cobra\Engine 
v1.0.1\). Use the Browse button to locate this file.

Check the This process is a Resident Process box.
Note: If the This process is compatible with Q2 v3.0 box 
is checked, you need to deselect it before you can select this 
option.

Set the Run this process as option to Hidden (no window 
visible). 

Set the Runtime priority to Normal.

Set all other options as shown in the previous ‘Processes’ 
dialog.

When you have finished, click on OK to return to the 
‘Overview’ dialog.

e: If you wish to add a barcode to the plates output in this 
ue then refer to section C.3 for instructions on how to do this 
 you have finished creating the queue.

cesses to run (InkMonitor users only)

‘Processes to run’ panel specifies which application(s) will 
ess your jobs. If you also wish to run the InkMonitor 
lication for this queue, jobs need to be passed to both the 

InkMonitor and TicketM

1. In the ‘Processes 
to display the foll

2. Do not set any op
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3.

4.

5.

6.

7.

8.

a\Engine v1.0.1\TicketMaker.exe) or click 
utton to display the ‘Application To Run’ 

obra\Engine v1.0.1 directory, select the 
 file then click on OK.

rocess is a Resident Process option.
 process is compatible with Q2 v3.0 box 
eed to deselect it before you can select this 

process as option to Hidden (no window 

es for this queue’ panel, set the Runtime 
al and the Processes in this queue 
 in series:

nished, click on OK to return to the 
eating a TicketMaker queue

In the ‘Process path’ panel, the path should specify the 
required InkMonitor application file (InkDuct.exe if you want 
to output to a printer or file, or CIP3.exe if you want to 
output CIP3 files). Either type the full path name of the 
executable InkMonitor file into the Path box (for example, 
D:\Cobra\Engine v1.0.1\InkDuct.exe) or click on the Browse 
button to display the ‘Application To Run’ dialog:

Navigate to the Cobra\Engine v1.0.1 directory, select the 
required InkMonitor executable file then click on OK.

Check the This process is a Resident Process box.
Note: If the This process is compatible with Q2 v3.0 box 
is checked, you need to deselect it before you can select the 
required option.

Set the Run this process as option to Hidden (no window 
visible).

Set the Runtime priority to Normal.

Now click on the Add Process button. The Path field will 
clear.

In the ‘Process path’ panel, the Path should specify the 
TicketMaker application file. Either type the full path name of 
the executable TicketMaker file into the Path box (for 

example, D:\Cobr
on the Browse b
dialog:

Navigate to the C
TicketMaker.exe

9. Select the This p
Note: If the This
is checked, you n
option.

10.Set the Run this 
visible). 

11.In the ‘All process
priority to Norm
should be run to

12.When you have fi
‘Overview’ dialog.
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Pro

The
that
para
the 
set 

1.

2.

3.

4.

ocessed, you need to specify what happens 
sed to the Imager queue, which outputs 
r). You specify this in the ‘Clean-Up’ dialog:

ge... button to display the ‘Clean-Up’ 

 options in the ‘Error handling’ panel. 
eating a TicketMaker queue

cess instructions

 ‘Process instructions’ panel lets you specify the ‘parameters’ 
 the TicketMaker application should run with. In this case, the 
meters are the plate and job position details that you saved in 
Layout file created in the Cobra Layout Tool (in chapter 13). To 
the process instructions:

Click on the Change... button to display the following dialog:

Click on the This is a file (enter file’s path in the box 
above) radio button.

For the Parameters, you need to specify the Layout file that 
you created in chapter 13 (for example, SM102.icf). Click on 
the Browse... button, locate the required Layout file then 
click on OK.
Note: The default directory for the Layout files is 
D:\Cobra\Engine v1.0.1.

Click on OK to return to the ‘Overview’ dialog.

Clean-Up

Once a job has been pr
to it next (jobs are pas
them to the platesette

1. Click on the Chan
dialog:

2. Do not select the
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3.

4.

5.

6.

Re

You 
one 
queu
Man

1.

2.

icketMaker queues (that is, queues 
ed for the platesetter, except for the 
pleted queues) must belong to the 
up.

entity field, type a unique name to identify 
e workflow name, for example, SM102).

nished, click on OK to return to the 
eating a TicketMaker queue

In the ‘Jobs that complete successfully’ panel, select Pass job 
to another queue (specified below).

In the ‘Next queue’ panel, type in Imager or click on the 
Browse... button to select it from the list of available queues.

Do not set any other options in this dialog (the previous 
dialog shows the correct settings).

When you have finished, click on OK to return to the 
‘Overview’ dialog.

source Management

need to set the ‘Resource Management’ options so that only 
TicketMaker queue is active at a time. All other TicketMaker 
es are automatically suspended. To set the ‘Resource 

agement’ options:

Click on the Change... button to display the ‘Identity’ dialog:

Select the required Mutex Group from the pull-down menu 
or, if there is no mutex group available, type in a new name 
(for example, Cobra Mutex Group 1). 

WARNING: All T
with jobs destin
Imager and Com
same mutex gro

3. In the Output Id
the queue (use th

4. When you have fi
‘Overview’ dialog.
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14
You 
dialo

Not
run’

o the ‘Queue Configuration’ dialog. You will 
e just created, for example:

required TicketMaker queues by following 
 chapter again.

hows you how to check the new queue(s) in 
tion 14.7 describes more Queue 
nd section 14.8 shows you how to set the 

references.

the new queue
d creating new queues, you should make 
d operating correctly in the Cobra Console. 

onfiguration application by clicking on OK.

n Cobra Console window by clicking on the 
eating a TicketMaker queue

.5 The finished queue
have now finished setting up the new queue. The completed 
g should look similar to this:

e: If you set up the queue to run InkMonitor, the ‘Process to 
 panel will be different.

Click on OK to return t
see the queue you hav

Now, create any other 
the instructions in this

The following section s
the Cobra Console. Sec
Configuration options a
Queue Configuration p

14.6 Checking 
When you have finishe
sure they are set up an
To do this:

1. Close the Queue C

2. Return to the mai
 button.
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3.

4.

5.

6.

ue Configuration options

ion’ dialog also contains the following 

ove a queue’s position up or down in the list 
 TicketMaker queues are displayed in the 
ppear here).

 that you keep the queues ordered as 
etMaker queues], Completed.

.
erences, as described in the next section.
eating a TicketMaker queue

Click on the Queue tab. You should now see the new 
queue(s) you have just created, for example:

You can check which processes it is configured to run in the 
‘Operation’ list:

The queue is now ready to output your jobs to the Cobra-8 
platesetter.

When you have finished creating all new queues, we 
recommend that you save the new information. Section 16.2 
shows you how to do this.

14.7 Other Que

The ‘Queue Configurat
buttons:

14.7.1 Up/Down
Use these buttons to m
(in the Cobra Console,
same order that they a
Note: We recommend
follows: Imager, [Tick

14.7.2 Preferences..
Use this to set the Pref
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14
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alth
need

To c

1.

2.

ncating, cut log file back to option to set 
 of the log file (in lines). 

exceeds the maximum size, it will 
truncated to the minimum size you have 
ecords are deleted first).

nished, click on OK to close the ‘General 
g.
 need to set any other options on this 
eating a TicketMaker queue

.8 Setting the preferences
‘General Preferences’ dialog sets a number of parameters 
ough, for use with the Cobra-8 system, the only settings you 
 to change are those for the log file size.

hange the log file size:

Click on the Preferences... button to open the ‘General 
Preferences’ dialog:

In the ‘Log file truncation’ panel, use the Truncate 
whenever file gets to option to set the maximum size of the 
log file (in lines).

3. Use the When tru
the minimum size

When the log file 
automatically be 
specified (oldest r

4. When you have fi
Preferences’ dialo
Note: There is no
dialog.
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15
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obta
diag
proc

Not
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supp

This

•

•

•

•

•

Not
dete
desc

 the Cobra Test Tool
 Tool, as described in section 7.6. The main 
w is displayed:
e Cobra Test Tool

. The Cobra Test Tool
Cobra Test Tool software is used to change the sound alerts, 
in Cobra-8 platesetter status information, and to test and help 
nose problems with the platesetter. This chapter describes the 
edures that you may need to use.

e: Apart from changing the sound alerts you will, typically, only 
y out the procedures in this chapter if asked to do so by a 
ort engineer.

 chapter includes the following sections:

15.1, Launching the Cobra Test Tool (p92).

15.2, Setting the preferences (p93).

15.3, Changing the sound alerts (p94).

15.4, The System Status test (p95).

15.5, The Disk Profile test (p97).

e: The Cobra Test Tool’s ‘Calibration Strips’ procedure (used to 
rmine the correct laser power setting for your plates) is 
ribed in chapter 18.

15.1 Launching
Launch the Cobra Test
‘Cobra Test Tool’ windo
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15
The 
add

To s

1.

2.

3.

w email before it is sent, check the Always 
ore sending box.

e the Debug Level. By default, the debug 
t at this value unless an engineer has asked 

aunch the Cobra Test Tool the debug level is 
. Higher debug levels give more information 

tics’ panel, check the Always show 
 test box to display test statistics, including 
ation count, and an indication of how the 
 (that is, pass, fail or active).

rting’ panel, check the Always show a 
ors are reported option to show an error 
as soon as the Cobra Test Tool generates an 

t checked, the status text in the Cobra Test 
 and you can see the error summary by 
 the flashing text.

e into some text fields in the Cobra Test 
, the ‘Strip Count’ on the ‘Plate Parameters’ 
lly edited or corrected by the software, if 
re that it does not contain illegal characters 

ithin the allowable range.

ion Delay’ panel lets you set the delay 
u type a value and when the Cobra Test Tool 
if it is out of range).

cking and amending user-typed values 
nd (that is, in the middle of the slider). 
 be faster or slower, as required.
acters are, in general, corrected 
 for example, you type G234 into a field it 
34.
e Cobra Test Tool

.2 Setting the preferences
‘Preferences’ dialog lets you specify units of measurement, the 
resses of email recipients and the debug level.

et the preferences:

Click on the Preferences tab to display the following pane:

Select Millimetres or Inches for the Display Units.

In the Mail Recipients box, type in the email address(es) 
where results from the Cobra Test Tool are to be sent.

If you are specifying more than one email address, separate 
them with a semicolon (but no spaces), for example:

support@highwater.co.uk;dev@colorprint.co.uk

Note: Contact your system administrator if the Cobra-8 
workstation has not been set up to send and receive emails.

4. If you want to vie
display mail bef

5. If required, chang
level is 1. Leave i
you to change it.
Note: When you l
always reset to 1
in the log file.

6. In the ‘Test Statis
statistics during
elapsed time, iter
test is proceeding

7. In the ‘Error Repo
dialog when err
summary pop-up 
error.

If this option is no
Tool will flash red
double clicking on

8. The value you typ
Tool (for example
tab) is automatica
necessary, to ensu
and that it falls w

The ‘Edit Verificat
between when yo
edits/corrects it (

The delay for che
defaults to 1 seco
Adjust the rate to
Note: Illegal char
immediately so if,
would correct to 2
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15
The 
duri
for t

To d

1.

ntrols from the pull-down menu at the top 
play the following dialog:

ouped as ‘themes’ to simplify the process of 
erent sets of sounds. Two standard themes 
obra-8 system:
e default setting, which plays no sounds.

 the sound set supplied with the Cobra-8 

es cannot be edited.

Ba
e Cobra Test Tool

.3 Changing the sound alerts
Cobra Test Tool lets you change the sound alerts that play 
ng the Cobra-8 platesetter’s operation. Sounds can be played 
he following alerts:

isplay the sound alerts dialog:

In the Cobra Test Tool, click on the System Tests tab.

2. Select Sound Co
of the pane to dis

15.3.1  Themes
The sound alerts are gr
switching between diff
are supplied with the C

• Silent — this is th

• Factory — this is
system.

Note: These them

Error Alert The sound played when the 
platesetter detects an error.

dly registered plate The sound played when the user fails 
to obtain good pin register on the 
register bar.

Load Plate The sound played when the 
platesetter requires the user to load a 
plate.

Unload Plate The sound played when the 
platesetter requires the user to unload 
a plate.

Close Cover The sound played when the 
platesetter requires the user to close 
the cover.
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15.3
To s

•

•

15.3
To c

1.

2.

3.

4.

5.

6.

heme

d Theme from the pull-down list.

ove button to remove the selected theme.

to confirm the deletion.

ove the standard themes (Silent and 

nd alerts
 for the current theme:

unds, uncheck the Enable All box.

fic sounds in the theme, make sure the 
 checked, then uncheck the individual 
rticular sound alert(s) you want to disable.

m Status test
st performs the following functions:

and firmware version numbers for the 
er.

nt settings for the Cobra-8 platesetter 

s with the Cobra-8 platesetter.

ly to run this test if requested to do so by 
e Cobra Test Tool

.2  Selecting a theme
elect a theme:

Either select the required Theme from the pull-down list

Or start typing the required theme name into the Theme 
field. After a short delay, the theme name matching your 
typing is shown.

Note: If the theme name you type does not exist, the New 
button is enabled and you can click on it to define a new 
theme, as described below.

.3  Creating a new theme
reate a new theme:

Type the new theme’s name into the Theme field.

Click on the New button.
Note: Initially, the new theme contains the sound files that 
were displayed when you clicked the New button.

To change the sound for a particular alert, click on the 
Browse button alongside it to display the ‘Open’ dialog.

Navigate to the appropriate directory (the default location is 
D:\Cobra\beep\sounds), highlight the required sound file and 
click on the Open button.
Note: Currently, only .wav files can be played.

To hear the sound sample, click on the Play button alongside 
the alert.
Note: If the file cannot be found, a default sound is played.

Click on the Cancel Test button to stop the sound playing.

15.3.4  Removing a t
To remove a theme:

1. Select the require

2. Click on the Rem

3. You will be asked 

Note: You cannot rem
Factory).

15.3.5  Disabling sou
To disable sound alerts

1. To disable all so

2. To disable speci
Enable All box is
box(es) for the pa

15.4 The Syste
The ‘System Status’ te

• Reports software 
Cobra-8 platesett

• Reports compone
hardware.

• Indicates problem

Note: You are only like
your support provider.
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1.

2.

3.

omplete, the results appear in the ‘Test 
r example:

ine’s sub-systems is shown with its 
n. If a machine sub-system’s icon is crossed 

) then it is not responding and needs 
ion from your support provider.

 the test report or mail it to your support 

 report: first make sure that a printer is 
our network, then click on the Print button. 

, you can send or fax the report to your 
ider.

 report: click on the Save button, select a 
n type in a file name. Click on the Save 

 report: click on the Mail button (make 
e set up one or more email addresses in the 
 dialog, as described in section 15.2). Your 
e will launch and send the email. If you 
he preferences to do so, the report will be 
ore it is sent.
e Cobra Test Tool

un the ‘System Status’ test:

Click on the System Tests tab, then select System Status 
from the pull-down menu at the top of the pane. The following 
dialog is displayed:

If you also want the test to report the contents of the 
Eeproms associated with each board, check the Get full 
Eeprom details box.
Note: This will slow the test down considerably, so do not 
select this option unless requested to do so by your support 
provider.

Click the Run Test button. You will see the message 
Scanning system, please wait... in the ‘Status’ panel.

4. When the test is c
Detail’ window, fo

Each of the mach
corresponding ico
through in red (
further investigat

5. You can now print
provider:

• To print the
available on y
Once printed
support prov

• To save the
directory, the
button.

• To email the
sure you hav
‘Preferences’
email packag
have set up t
displayed bef
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15
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disk
avai

To a

1.

est options
e options for the test(s). To do this:

l’ window, right-click on the required drive 
st Options from the pop-up menu. The 
pears:

e you can choose to test a File and/or a 

a file, to get more accurate test results, 
e file (greater than 10Mb). It is not possible 
a file so only select the Read option. 

rowse... button and select the file from the 

a disk, profiling may use all the available 
 the drive. You MUST select both the Read 
sts otherwise the ‘Read’ results will be 

 a specified size (even if the file size/disk 
ter than this value), check the Limit Test 
lue into the Test size limit (in bytes) 
t limit the test, the entire file or free disk 
d, depending on the test mode.
e Cobra Test Tool

.5 The Disk Profile test
‘Disk Profile’ test checks the speed/data rate of the selected 
(s) and/or file(s). You can run the disk profile tests on all 
lable drives or on individual drives.

ccess the ‘Disk Profile’ test:

Click on the System Tests tab, then select Disk Profile from 
the pull-down menu to display the following:

The ‘Test Detail’ window lists each drive on the Cobra-8 
workstation.

15.5.1  Setting the t
First you need to set th

1. In the ‘Test Detai
and select Set Te
following panel ap

2. For the Test Mod
Disk:

• If checking 
choose a larg
to write-test 

Click on the B
dialog.

• If checking 
free space on
and Write te
inaccurate.

3. To limit the test to
free space is grea
box and type a va
field. If you do no
space may be use
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15.5
You 
indiv

Run

To r

1.

2.

dividual drives:

dividual drive:

ions for the required drive, as described in 

 drive, and select Profile from the pop-up 

r the drive are displayed in the ‘Test Detail’ 
ple:

lts
t of write and read statistics as follows:

 Expanding the item will display the 
e and maximum data rates. An average 
b/s is acceptable.

 Expanding the item will display the 
e and maximum data rates. An average 
 Mb/s is acceptable.

ailing the test results
plete you can print, save or mail them:

e results to the selected printer.

e results to the specified file.
e Cobra Test Tool

When you have finished setting the options, click on the Set 
button.

.2  Running the Disk Profile tests
can either run the disk profile tests on all listed drives, or on 
idual drives, as described in the following sub-sections.

ning the tests on all drives:

un the test for all drives:

Set the Test Options for all the drives, as described in the 
previous sub-section.

Click on the Run Test button. After a while, the test results 
are displayed in the ‘Test Detail’ window, for example:

See section 15.5.3 for a description of these results.

Running the tests on in

To run the test on an in

1. Set the Test Opt
section 15.5.1.

2. Right click on the
menu.

3. The test results fo
window, for exam

15.5.3  The test resu
The test results consis

• Write Statistics:
minimum, averag
data rate of 6–8 M

• Read Statistics:
minimum, averag
data rate of 8–12

15.5.4  Printing or m
Once the tests are com

• Print — Prints th

• Save — Saves th
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•

e Cobra Test Tool

Mail — Mails the results to the email recipient(s) listed in the 
‘Preferences’ dialog (as described in section 15.2).

It is possible to print and/or mail a subset of the results by 
right clicking on the Write statistics or Read statistics 
items. A sub-menu appears with the following options:

Select one of the following options:

• Print this selection — Print the expanded selection to 
the selected printer.

• Mail this selection — Mail the expanded selection to the 
recipient(s) specified in the ‘Preferences’ panel.
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16
The 
files
and

d, you can then restore these settings, for 
t settings get deleted or corrupted.

 Torrent RIP settings.

-8 system settings
bra-8 system settings:

 Test Tool, if it is not already running (refer 
instructions on how to do this).

em Tests tab, then select System 
 from the pull-down menu to display the 

he current folder are shown in the Archive 
rowse... button to change the current 
intenance

. Maintenance
 chapter shows you how to carry out routine maintenance on 
 Cobra-8 system. It includes the following sections:

16.1, Cleaning the Cobra-8 drum (p100).

16.2, Saving Cobra-8 system settings (p100).

.1 Cleaning the Cobra-8 drum

RNING: All maintenance to the Cobra-8 platesetter, 
er than that described here, should only be carried out 
n approved HighWater engineer. Any damage to the 
ra-8 platesetter resulting from user carelessness or 
-approved maintenance is not covered by HighWater’s 
ranty. 
 laser beam used in the Cobra-8 platesetter is harmful to 
eyes, so do not attempt to remove the laser carriage 
er.

drum and inside of the Cobra-8 platesetter need to be kept as 
n as possible to minimize the risk of dust, dirt and other 
icles contaminating your plates and the Cobra-8 platesetter. 

should inspect the Cobra-8 drum and the surrounding areas 
y time you load a plate, and you should periodically clean the 
. We recommend that you carefully clean the drum and 

ounding areas with a vacuum cleaner hose and lint-free cloth.

.2 Saving Cobra-8 system settings
Cobra Test Tool lets you save Cobra-8 software settings (ICF 
 and plate and layout information from the Cobra Layout Tool, 
 the Q2 queues created by the Queue Configuration 

application). If require
example, if your curren

Note: You cannot save

16.2.1 Saving Cobra
To save the current Co

1. Launch the Cobra
to section 7.6 for 

2. Click on the Syst
Archive/Restore
following dialog:

Archived files in t
list (click on the B
folder).
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3.

rmation to save by checking the appropriate 

Configuration Files: These are the Layout 
) created in the Cobra Layout Tool — they 
ion about plate size and image position on 

Plate Layouts: These contain the plate and 
ation created in and used by the Cobra 

figuration Files: These contain the Cobra 
e information (that is, the queues created in 
nfiguration application).

end that you select all three file types.

ct the location of the CTP Engine 
les and Spooler Configuration Files 
.. button(s) — the default locations of these 
\Engine v1.0.1 for the CTP Engine 
s and D:\Cobra\Q2v4.4 for the Spooler 
s.
hould only be required if more than one 
he Cobra software is installed on the 

nished setting the Advanced options, click 
utton.

l’ panel, select an Archive Folder by 
owse... button. Locate the required folder 
OK button.
t folder is D:\Cobra\Engine Archive. We 
you always use this folder.

ive button to save the information to file.
intenance

The ‘Info’ panel shows a summary of the most recently 
performed operation (when a new operation is performed the 
previous operation’s details are removed from the ‘Info’ 
panel).

Click on the Advanced... button to display the following 
dialog:

Notes: There may be a delay (sometimes long) before this 
dialog is displayed because the program first tries to locate 
the relevant software applications on the computer.

If the Q2 software cannot be found, you will not see the 
‘Spooler Configuration Files’ field.

4. Select the file info
boxes:

• CTP Engine 
files (ICF files
hold informat
the plate.

• CTP Engine 
layout inform
Layout Tool.

• Spooler Con
Console queu
the Queue Co

Note: We recomm

5. If necessary, sele
Configuration Fi
using the Locate.
files are D:\Cobra
Configuration File
Configuration File
Note: This step s
version of Q2 or t
machine.

6. When you have fi
on the Finished b

7. In the ‘Test Detai
clicking on the Br
then click on the 
Note: The defaul
recommend that 

8. Click on the Arch
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16.2

WA
curr
you

To r

1.

2.

3.

4.

ore button.

will not be informed if an error occurs 
re process. Therefore, immediately 
he archive, scroll through the ‘Info’ 
here are any errors.

rchive
that are no longer required:

ct the required Archive Folder using the 
.
t folder is D:\Cobra\Engine Archive.

ive in the Archives list, then click on the 

to confirm that you wish to delete the 

lete the selected archive.
intenance

The archive file name has the following structure:
ArchivedOn_[date:year/mm/dd]_[time:hours/mins/secs]

For example, ArchivedOn_20070117_143309

WARNING: You will not be informed if an error occurs 
during the archiving process. Therefore, immediately 
after creating the archive, scroll through the ‘Info’ 
panel to see if there are any errors.

.2 Restoring an archive

RNING: Restoring an old archive will overwrite your 
ent settings, so first save your current settings in case 
 should later need them.

estore previously archived settings:

Click on the Advanced... button and select the file types to 
be restored (CTP Engine Configuration Files, CTP Engine 
Plate Layouts, Spooler Configuration Files).

Click on the Finished button.

In the ‘Test Detail’ panel, select the required Archive Folder 
using the Browse... button.
Note: The default folder is D:\Cobra\Engine Archive.

Select the file you wish to restore from the list of Archive 
files:

5. Click on the Rest

WARNING: You 
during the resto
after restoring t
panel to see if t

16.2.3 Deleting an a
To delete old archives 

1. If necessary, sele
Browse... button
Note: The defaul

2. Highlight the arch
Delete... button.

3. You will be asked 
archive:

4. Click on Yes to de
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17
This
com
find
supp

This

•

•

•

•

•

IP problems
ms you may encounter when using the 
fer to the Torrent User’s Guide for a 
rrors that can occur within the RIP.) 
 is also useful for troubleshooting as it 
bout what the RIP is doing.

tosh Classic, an input queue does not 
r

ons why a Torrent input queue does not 
on the Macintosh:

e running, or the Torrent workstation may 

 broadcast your input queues (refer to 

ay be switched off in the Input Controller 
.4.3).

cted the correct options in the Chooser 
.6.2).

d. If so, re-start the system and re-RIP any 
ing processed when the crash occurred.

has occurred, possibly due to a cable fault 
e has become disconnected from a machine. 
oubleshooting

. Troubleshooting
 chapter provides troubleshooting information for some 
mon problems. If you cannot solve your particular problem or 
 the help you need, please contact your authorized Cobra-8 
ort provider.

 chapter covers the following problems:

17.1. Torrent RIP problems (p103):

• 17.1.1 On the Macintosh Classic, an input queue does not 
appear in the Chooser (p103).

• 17.1.2 ‘Insufficient disk space’ error (p104).

17.2. Cobra Console problems (p104):

• 17.2.1 No jobs are being processed (p104).
• 17.2.2 The Cobra Console will not re-launch (p104).

17.3. Cobra Layout Tool problems (p104):

• 17.3.1 There is no Save button on the ‘Layout’ window 
(p104).

17.4. Plate problems (p104):

• 17.4.1 Fogged plates (p104).
• 17.4.2 Dirty plates (p104).
• 17.4.3 Over/under-exposed plates (p105).

17.5. Cobra-8 platesetter problems (p105).

17.1 Torrent R
Below are some proble
Torrent RIP. (Please re
comprehensive list of e
Torrent’s main window
provides information a

17.1.1  On the Macin
appear in the Choose
There are several reas
appear in the Chooser 

• Torrent may not b
be switched off.

• You may not have
section 6.6.1).

• The input queue m
(refer to section 6

• You have not sele
(refer to section 6

• Torrent has crashe
jobs that were be

• A network failure 
or because a cabl
Check all cabling.
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17.1
If yo
will 

Mak
be r

17
Belo
Cob

17.2
Che
that
indiv

17.2
If th
men

1.

2.

3.

out Tool problems
ms you may encounter when using the 

ave button on the ‘Layout’ window
has a Start button instead of a Save 

rences tab.

 Setup’ panel, select the Layout editor 
 click the Apply button.

indow there should now be a Save button.

lems
roblems you may encounter.

s
hey are exposed to light sources other than 
lights for the plate type. Please see 
ation about protecting your plates from 

m fingerprints and dust/dirt particles from 
surrounding areas. Therefore, it is essential 
 carefully and keep the Cobra-8 platesetter 
hows you how to do this.
oubleshooting

.2  ‘Insufficient disk space’ error
ur disk runs out of space while a job is being RIPed, Torrent 
display a warning message, for example:

System warning - Insufficient disk workspace

System warning: Free disk space has gone below 
requested limit

e some more free space available on your disk and the job will 
e-processed.

.2 Cobra Console problems
w are some problems you may encounter when using the 
ra Console.

.1  No jobs are being processed
ck that the overall Cobra Console processing status is on and 
 the Imager queue status is active. Also check the status of 
idual queues and jobs as these may have been suspended.

.2  The Cobra Console will not re-launch
e Cobra Console will not re-launch from the Windows Start 
u, or you experience problems running it after a re-launch:

Close all running applications (refer to section 5.3 for 
instructions on how to this properly).

Log off the Cobra-8 workstation.

Log back on again using the username Cobra with no 
password.

17.3 Cobra Lay
Below are some proble
Cobra Layout Tool.

17.3.1  There is no S
If the ‘Layout’ window 
button:

1. Click on the Prefe

2. In the ‘Application
radio button, then

3. On the ‘Layout’ w

17.4 Plate prob
Below are some plate p

17.4.1  Fogged plate
Your plates will fog if t
the appropriate safety 
section 3.3.3 for inform
light exposure.

17.4.2  Dirty plates
Plates can get dirty fro
the Cobra-8 drum and 
that you handle plates
clean — section 16.1 s
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17
If th

•

•

•

oubleshooting

.3  Over/under-exposed plates
ates are consistently over- or under-exposed over the whole 
e area you should check the laser power setting for the plate — 
ter 18 shows you how to do this.

e: You should also re-calibrate your Torrent page setups if you 
having expose problems or if you change the laser power 
ing for a plate.

e over- or under-exposure does not occur consistently over the 
le plate, please call your support provider for further advice.

.5 Cobra-8 platesetter problems
e Cobra-8 platesetter is not functioning properly:

Check that the platesetter and both its vacuum units are 
switched on.

Check the status lights on the front of the platesetter. If the 
red light is on or flashing (as shown below), shut down then 
restart the whole Cobra-8 system (platesetter and 
workstation). If the problem persists, call your support 
provider for further help.

Check all cabling to and from the Cobra-8 workstation and 
platesetter.

If the red light on the front of the Cobra-8 platesetter
is on or flashing, this indicates an error.
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18

You 
outp
lase

•

•

•

•

•

18
set
You 
any 

•

•

•

•

 of determining the laser 
for your plates
g the correct laser power setting for your 
owing steps:

 Test Tool.

ation Strips’ job to plate.

 density patches on the plate, and find the 
he correct reading.

to the Cobra Layout Tool’s plate information 

covered in the following sections.

ck and set the laser power setting for every 
u use.
ecking the laser power setting for your plates

. Checking the laser power 
setting for your plates

need to check the laser power setting for your plates to ensure 
ut quality. This chapter describes how to determine the correct 
r power settings, and it includes the following sections:

18.1, When to check the laser power setting (p106).

18.2, Overview of determining the laser power setting for 
your plates (p106).

18.3, Outputting the Calibration Strips job (p107).

18.4, Measuring the plate densities (p108).

18.5, Setting the laser power in the Cobra Layout Tool 
(p110).

.1 When to check the laser power 
ting
need to check the laser power settings for your plates when 
of the following occur:

You start a new box of plates.

You use a new type of plate (for example, a different size or 
thickness).

You change your processor chemistry.

If plates are consistently over-exposed or under-exposed over 
the whole plate area.

18.2 Overview
power setting 
Determining and settin
plates involves the foll

1. Launch the Cobra

2. Output the ‘Calibr

3. Measure the 50%
patch that gives t

4. Enter this value in
section.

Each of these steps is 

Note: You need to che
plate size/type that yo
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18
The 
the 

1.

2.

3.

m Tests tab and select Calibration Strips 
n menu at the top of the pane. The following 
:

ate Name and details are correct.
 the mouse cursor over the plate name, the 
 appear, for example:
ecking the laser power setting for your plates

.3 Outputting the Calibration Strips job
first stage in determining the correct laser power setting for 
plate is to output the Calibration Strips job. To do this:

Launch the Cobra Test Tool, as described in section 7.6.

To set up the plate details, click on the Plate Parameters 
tab to display the following:

Select the required plate from the Name menu and check 
that the plate settings (Width, Height, Thickness, etc.) are 
correct.
Notes: The plates available in the Name menu are those that 
were created in the Cobra Layout Tool. If the required plate is 
not available in the list, you need to create it now using the 
Cobra Layout Tool (this is covered in section 13.6).
Do not change the values in the ‘Calibration Strips’ panel.

4. Click on the Syste
from the pull-dow
dialog is displayed

5. Check that the Pl
Note: If you place
plate’s details will
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6.

7.

8.

9.

10

11

12

Mea

 the plate densities
ob consists of 50% and 2% patches laid out 
milar to this:

r power setting for this plate:

w of 50% patches to measure (it does not 
 you choose).

sitometer, and starting from either the left 
 of the plate (and with the grip edge at the 
 each 50% patch in the row until you get a 

Plate’s grip edge

Slow-scan direction
ecking the laser power setting for your plates

Click on the Browse button and select the 
CalStrip_835mm_175lscr.TIF file then click on the Open 
button.
Note: The default directory for this file is D:\Cobra\Engine 
v1.0.1\calibration jobs.

In the ‘Controls’ panel, select I want to Power Sweep.

Enter 12.00 % for the Start Power.

Enter 3.00 % for the Power Step.

.Now load the plate into the Cobra-8 drum (refer to chapter 9 
for full details on doing this).
Note: Make sure you load the plate for which you are 
determining the laser power setting.

.When the plate is loaded, close Cobra-8’s cover and click on 
the Run Test button. The Cobra Test Tool will image the plate 
with the Calibration Strips job.

.When the plate has been imaged, remove it from the Cobra-8 
platesetter and process it.

suring the plate densities is covered in the next section.

18.4 Measuring
The Calibration Strips j
in rows and columns si

To find the correct lase

1. Select any one ro
matter which row

2. Using a plate den
or right hand side
bottom), measure

F
a
st

-s
ca

n
 d

ir
e
ct

io
n
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 right-hand edge of the selected patch is a 
t, which includes the date, plate size, job 
ion, for example:

tains a laser power value (34.00% in the 
which is the correct setting for your plate. 
his laser power value.
y, keep reading up/down the line of text 
e Power setting.

R
esolu

tion
=

 2
5
4
0
.0

d
p
i P

ow
er=

 3
4
.0

0
%

 P
late=

 1
0
3

2
4

2
3

2
2

2
1

2
0

ecking the laser power setting for your plates

reading of approximately 52% for a positive working plate, or 
58% for a polymer, negative working plate.
Note: For correct readings for other types of plate, please 
contact your dealer.

3. Running down the
vertical line of tex
name and resolut

4. This text also con
above example), 
Make a note of t
Note: If necessar
until you reach th

Select one 50% row of patches and, starting at one end of the 
row, measure each patch until you get the required reading

17

18

19

20
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18
Lay
Onc
you 

1.

2.

3.

4.

5.

ower (%) setting, obtained from the 
 job.

y button to save the information.

yout Tool when you have finished.
ecking the laser power setting for your plates

.5 Setting the laser power in the Cobra 
out Tool

e you have determined the correct laser power for your plate, 
need to specify it in the Cobra Layout Tool. To do this:

Launch the Cobra Layout Tool, as described in section 7.7.1.

Click on the Layout tab and select the Layout associated 
with the plate.

Click on the Plate tab to display the ‘Plate’ pane:

Select the required Plate Name from the pull-down list.

Check that the Height, Width, Thickness and Type are 
correct.

6. Enter the Laser p
Calibration Strips

7. Click on the Appl

8. Close the Cobra la
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19

Befo
app
from
you 
pag
to th

This

•

•

•

•

•

•

•

he PPDs to the page make-

 the Cobra-8 PPDs to every page make-up 
 printing to Torrent from.

-8 PPDs at the following locations:

orkstation at:
v1.0.1\PPDs\8-up

D supplied with your system.

 will find the following sub-folders:

 contains the PPD file for the Macintosh 
.

s folder contains the PPD file for 
ing Windows XP, Windows 2000 and 
003.

der contains the PPD file for workstations 
 NT.

der contains the PPD file for workstations 
 95 and 98.

ra-8 PPDs for Mac Classic
Ds to a Mac Classic workstation:

he Printer Descriptions folder on your 
drive. This is usually located at:

:System Folder:Extensions:Printer 

 PPD (from the Mac folder) into this folder.
eating a print queue on the page make-up workstation

. Creating a print queue on 
the page make-up 
workstation

re printing to the Torrent RIP, you need to copy the 
ropriate Cobra-8 PPD onto each workstation you are printing 
, and create a Cobra-8 ‘printer’ for each Torrent input queue 
will be printing to. This printer will let you send jobs from the 
e make-up workstation to the Torrent RIP (for eventual output 
e Cobra-8 platesetter).

 chapter includes the following sections:

19.1, Copying the PPDs to the page make-up workstation 
(p111).

19.2, Creating a print queue on a Mac OSX workstation 
(p112).

19.3, Creating a print queue on a Mac Classic workstation 
(p114).

19.4, Creating a print queue on a Windows 2000/Server 2003 
workstation (p115).

19.5, Creating a print queue on a Windows XP workstation 
(p118).

19.6, Creating a print queue on a Windows NT workstation 
(p120).

19.7, Creating a print queue on a Windows 95/98 workstation 
(p123).

19.1 Copying t
up workstation
First, you need to copy
workstation you will be

You can find the Cobra

• On the Cobra-8 w
D:\Cobra\Engine 

• On the Cobra-8 C

In the PPDs folder, you

• Mac — this folder
(Classic and OSX)

• Win2K_XP — thi
workstations runn
Windows Server 2

• WinNT — this fol
running Windows

• Win9x — this fol
running Windows

19.1.1  Copying Cob
To copy the Cobra-8 PP

1. Locate and open t
Macintosh’s hard 

Macintosh HD
Descriptions

2. Copy the Cobra-8
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19.1
Win
Not
the 
sect

To c

1.

19.1
On W
and
you 

1.

2.

3.

19
wo
To c

1.

2.

 page make-up workstation: launch the 
rinter Setup Utility’ application (you can 
ck at the bottom of the screen). You will see 
ialog:

icon to display the following window:

 from the top pull-down list.
eating a print queue on the page make-up workstation

.2  Copying Cobra-8 PPDs onto Mac OSX and all 
dows workstations
e: If you are using Windows XP and are updating/re-installing 
Cobra-8 PPD files then please follow the instructions in 
ion 19.1.3 below first.

opy the Cobra-8 PPDs to a Mac OSX or Windows workstation:

Copy the relevant PPD folder (Mac, Win2K_XP, WinNT or 
Win9x) onto the workstation. Make a note of the location as 
you will need to find the folder later when you create the 
Cobra-8 print queue.

.3  Updating/re-installing PPDs for Windows XP
indows XP, if you are updating/re-installing a Cobra-8 PPD file 

 it is intended to replace an existing PPD with the same name, 
first need to remove the existing PPD. To do this:

Check that the PPD you wish to delete is not being used by 
any currently installed printers. If it is, you should delete the 
printers then recreate them after you have re-installed the 
PPD file.

In Windows Explorer, navigate to the 
Windows\System 32\Spool\Drivers directory.

Locate and delete the .ppd file you are intending to re-install.

.2 Creating a print queue on a Mac OSX 
rkstation
reate a Cobra-8 print queue on a Mac OSX workstation:

If you haven’t done so already, copy the relevant PPD file to 
the Mac OSX workstation (see section 19.1.2).

In Torrent: broadcast the input queues by selecting Start 
Inputs... from the Torrent menu (so there is a tick by it).

3. On the Mac OSX
‘Print Center’ or ‘P
find this on the do
the ‘Printer List’ d

4. Click on the Add 

5. Select AppleTalk
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6.

7.

8.

9.

ee the Cobra-8 PPD file listed for the Printer 

button.

ew printer in the Printer List:

 to this printer, as described in section 6.6.

ter for any other Torrent input queues you 
 following the instructions in this section 
eating a print queue on the page make-up workstation

Select the required zone, if applicable, from the second pull-
down list.
Note: This is the zone where the Torrent input queues are 
broadcast.

Highlight the required Torrent input queue from the list of 
available printers.

From the Printer Model menu, select Other... to display the 
‘Choose a File’ dialog:

Locate the Cobra-8 PPD file that you copied to the machine 
earlier (usually called HWCobra-8up.ppd), then click on the 
Choose button.

10.You should now s
Model:

11.Click on the Add 

12.You will see the n

13.You can now print

14.Now, create a prin
wish to print to by
again.
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19
Cla
To c

1.

2.

3.

4.

ired Torrent input queue in the right-hand 
 on the Create button to display the 

8 PPD (usually called HWCobra-8up.ppd) 
 click on the Select button. The printer is 
esktop.

r.

 to this printer, as described in section 6.6.

ter for any other Torrent input queues you 
 following the instructions in this section 
eating a print queue on the page make-up workstation

.3 Creating a print queue on a Mac 
ssic workstation

reate a print queue on a Mac Classic workstation:

If you haven’t done so already, copy the relevant Cobra-8 
PPD file to the Mac Classic workstation (see section 19.1.1).

In Torrent: broadcast the input queues by selecting Start 
Inputs... from the Torrent menu (so there is a tick by it).

On the Mac Classic page make-up workstation: launch 
the Chooser.

Click once on the LaserWriter icon in the top left-hand 
window, and then on the required AppleTalk Zone, if 
applicable. The names of the available Torrent input queues 
appear in the right hand window along with any other 
printers:

5. Highlight the requ
window, then click
following dialog:

6. Select the Cobra-
from the list then
now built on the d

7. Close the Choose

8. You can now print

9. Now, create a prin
wish to print to by
again.
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19
20
To c
wor

1.

2.

3.

4.

l printer radio button and make sure that 
ly detect and install my Plug and Play 
not selected. Click on Next to display the 

te a new port radio button and select 
ng Devices from the Type pull-down 

isplay the following dialog:
eating a print queue on the page make-up workstation

.4 Creating a print queue on a Windows 
00/Server 2003 workstation
reate a print queue on a Windows 2000/Server 2003 
kstation:

If you haven’t done so already, copy the relevant Cobra-8 
PPD folder to the Windows 2000/Server 2003 workstation 
(see section 19.1.2).

In Torrent: broadcast the input queues by selecting Start 
Inputs... from the Torrent menu (so there is a tick by it).

Depending on your platform, do either of the following:
• On the Windows 2000 page make-up workstation: 

from the Start menu, choose Printers from the 
Settings sub-menu to display the ‘Printers’ dialog.

• On the Windows Server 2003 page make-up 
workstation: from the Start menu, choose Printers 
and faxes to display the ‘Printers’ dialog.

Double-click on Add Printer to display the ‘Add Printer 
Wizard’. Click on Next to display the following dialog:

5. Click on the Loca
the Automatical
printer option is 
following dialog:

6. Click on the Crea
AppleTalk Printi
menu. 

7. Click on Next to d
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8.

9.

10

11

12

13

nd select the setup.inf file. Click on the 

e ‘Install From Disk’ dialog.

r Wizard’, Cobra-8 should now be listed. 
 button to display the following dialog:

ame (give it the same name as the Torrent 
n select whether you want this to be the 
ick on Next.

ou want the printer to be shared, then click 

o print a test page (we recommend that you 
 Next.

izard now displays a summary of your 
at the information is correct then click on 

e information is incorrect, click on the Back 
et to the required screen, then edit the 
eating a print queue on the page make-up workstation

Double-click on the required AppleTalk zone, if applicable, to 
open the list of printers:

Select the required Torrent input queue then click on OK.

.When you are asked if you want to capture the device, click 
on No.

.Next, you are asked for the printer manufacturer and model. 
Click on Have Disk... to display the ‘Install From Disk’ dialog:

.Click on the Browse... button to display the ‘Locate File’ 
dialog.
Note: If you get an error ‘The device is not ready’, click on 
the Cancel button. The ‘Locate File’ dialog is then displayed.

.In the ‘Locate File’ dialog, navigate to the Win2k_XP PPD 
folder that you copied to your workstation earlier.

14.Open the folder a
Open button.

15.Click on OK on th

16.In the ‘Add Printe
Click on the Next

17.Edit the Printer n
input queue), the
default printer. Cl

18.Choose whether y
on Next.

19.Choose whether t
do), then click on

20.The Add Printer W
choices. Check th
Finish.
Note: If any of th
button until you g
information.
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21

22

23

ished, you will see the printer you have just 
nters’ dialog:

 to this printer, as described in section 6.6.

ter for any other Torrent input queues you 
 following the instructions in this section 
eating a print queue on the page make-up workstation

.Windows 2000 setup only: If the message ‘Digital 
Signature Not Found’ appears, click on Yes to continue with 
the installation.

.Windows Server 2003 setup only: If the following warning 
dialog appears select the Continue Anyway option, 
otherwise the PPD will not be installed:

.If you chose to print a test page, you are asked if the test 
page printed out correctly:

Check that the test page is in the Torrent RIP’s Output 
Controller, then click on the OK or Troubleshoot... button, 
depending on whether the page printed out correctly or not.

24.When you have fin
created in the ‘Pri

25.You can now print

26.Now, create a prin
wish to print to by
again.
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19
XP
Not
inpu
Prot
You 
insta

Onc
crea
as d

1.

2.

3.

4.

 button to display the following dialog:

 printer, or a printer attached to 
er then click on Next.

og is displayed:
eating a print queue on the page make-up workstation

.5 Creating a print queue on a Windows 
 workstation
es: On Windows XP you cannot print to the AppleTalk Torrent 
t queue(s) until you have installed the Miramar AppleTalk 
ocol from Miramar Systems Inc.
may need to ask your system administrator for help with 
lling and setting up the Miramar AppleTalk protocol.

e you have installed the Miramar AppleTalk Protocol, you can 
te the Torrent print queues on your Windows XP workstation, 
escribed below:

If you haven’t done so already, copy the relevant Cobra-8 
PPD folder to the Windows XP workstation (see 
section 19.1.2).

In Torrent: broadcast the input queues by selecting Start 
Inputs... from the Torrent menu (so there is a tick by it).

On your Windows XP page make-up workstation: from 
the Start menu select Settings > Printers and Faxes. The 
‘Printers and Faxes’ window is displayed.

Select Add Printer from the File menu. The ‘Add Printer 
Wizard’ is displayed.

5. Click on the Next

6. Select A network
another comput

7. The following dial
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8.

9.

10

11

12

13

ed to locate the printer driver file. Click on 
the file. The following dialog is displayed:

k... to display the ‘Install From Disk’ dialog.

se... button to display the ‘Locate File’ 

’ dialog, navigate to the Cobra-8 PPD folder 
 your workstation earlier, open the folder 

tup.inf file. Click on the Open button.

m Disk’ dialog you will now see the Cobra-8 
 on OK.
eating a print queue on the page make-up workstation

Select the Browse for a printer option then click on the 
Next button. The system searches for printers on the 
network and displays a list of what it finds, for example:

Double-click on the Miramar Systems’ AppleTalk Print 
Provider option to display the list of available AppleTalk 
zones.

.If necessary, double-click on the required AppleTalk zone to 
display the list of available printers. The published Torrent 
input queue(s) should be listed here.

.Highlight the required Torrent input queue and click on Next.

.You will see the following message asking you to select a 
printer driver file:

.Click on OK.

14.Next, you are ask
OK to search for 

15.Click on Have Dis

16.Click on the Brow
dialog:

17.On the ‘Locate File
that you copied to
and select the se

18.On the ‘Install Fro
print queue. Click
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19

20

21

22

23

24

25

 print queue on a Windows 

he Windows NT Installation disk to 
this installation.

 on a Windows NT workstation:

e so already, copy the relevant Cobra-8 
Windows NT workstation (see 

dcast the input queues by selecting Start 
e Torrent menu (so there is a tick by it).

s NT page make-up workstation: from 
t menu, choose Printers from the 
nu to display the ‘Printers’ dialog.

dd Printer. The ‘Add Printer Wizard’ is 

ter then click on Next.
eating a print queue on the page make-up workstation

.You should now see the Cobra-8 print queue listed in the Add 
Printer Wizard, for example:

.Click on OK.

.Choose whether the printer is to be the default printer: select 
Yes or No then click on Next.

.Next, a dialog is displayed summarizing the choices you have 
made. Click on Finish.

.In the ‘Printers and Faxes’ dialog you should now see the 
printer you have just created.

.You can now print to this printer, as described in section 6.6.

.Now, create a printer for any other Torrent input queues you 
wish to print to by following the instructions in this section 
again.

19.6 Creating a
NT workstation
Note: You may need t
successfully complete 

To create a print queue

1. If you haven’t don
PPD folder to the 
section 19.1.2).

2. In Torrent: broa
Inputs... from th

3. On your Window
the Windows Star
Settings sub-me

4. Double-click on A
displayed:

5. Select My Compu
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6.

7.

8.

e AppleTalk zone, if applicable, where the 
ues are broadcast to display the available 

ired Torrent input queue and click on OK.

ed if you want to capture the device. Click 

rts’ dialog, click on Close.

r Wizard’ dialog, click on Next.

d to select the printer manufacturer and 
ave Disk... to display the ‘Install From Disk’ 

se... button.
an error ‘The device is not ready’, click on 
n. The ‘Locate File’ dialog is then displayed.
eating a print queue on the page make-up workstation

The currently available ports are displayed:

Click on the Add Port... button.

Double-click on AppleTalk Printing Devices to display the 
list of available zones, for example:

9. Double-click on th
Torrent input que
printers dialog:

10.Highlight the requ

11.Next, you are ask
on No.

12.On the ‘Printer Po

13.On the ‘Add Printe

14.You are now aske
model. Click on H
dialog:

15.Click on the Brow
Note: If you get 
the Cancel butto
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16

17

18

19

20

21

22

int a test page, you are asked if the test 
ectly. Check this in the Torrent RIP’s Output 
ick on the Yes or No button, depending on 
 printed correctly or not.

he printer you have just created in the 

 to this printer, as described in section 6.6.

ter for any other Torrent input queues you 
 following the instructions in this section 
eating a print queue on the page make-up workstation

.In the ‘Locate File’ dialog, navigate to the Cobra-8 PPD folder 
that you copied to your workstation earlier, open the folder 
and select the setup.inf file. Click on the Open button.

.Click on OK on the ‘Install From Disk’ dialog.

.You should now see Cobra-8 listed in the Add Printer Wizard. 
Click on Next to display the following dialog:

.Type in a new printer name (use the same name as the 
Torrent input queue) then select whether you want this 
printer to be your default printer. Click on Next.

.When you are asked if the printer will be shared or not, select 
Not shared then click on Next.

.Choose whether to print a test page (we recommend that you 
do), then click on Finish.

.While the printer is being configured, you may be asked to 
insert the Windows NT Installation CD in order to complete 
the installation.
Note: You may need to locate the required files on the CD.

23.If you chose to pr
page printed corr
Controller, then cl
whether the page

24.You will now see t
‘Printers’ dialog:

25.You can now print

26.Now, create a prin
wish to print to by
again.
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19
95
If yo
you 

1.

2.

3.

Plea
the 
NTp

Alte
MAC
to se
mor
eating a print queue on the page make-up workstation

.7 Creating a print queue on a Windows 
/98 workstation
u are printing from a workstation running Windows 95 or 98 
need to carry out the following steps:

Set up an input queue in the Torrent RIP using NTprint.

Broadcast the input queue then generate a shared printer on 
a Windows NT or Windows 2000 machine using the 
ScriptWorks protocol.

Set up the printer on your Windows 95/98 machine.

se see your system administrator for more help and refer to 
Torrent User’s Guide for more information about using 
rint.

rnatively, you can use a software application such as PC 
LAN to print directly to the RIP, via AppleTalk, without having 
t up an NTprint queue. Refer to the Torrent User’s Guide for 

e information about this.
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A
Im
This
Cob
plat

Ther
alre
syst
dele
can 
defin
man
Con

This

•

•

•

•

•

or the Imager queue
 queue exists:

ole, click on the Queues tab.

, you should see the Imager queue plus any 
es that have been created, for example:

ue is not in this list then you need to create 
 this chapter. Alternatively, if there is an 
t you think its settings may be wrong you 
om the instructions given in section A.3.

e Imager queue by copying 
iles
ger queue by copying specific configuration 
irectory. However, in doing this, all existing 
ll be deleted, which means you will have to 
 have a lot of TicketMaker queues or do not 
dix A. Creating the Imager queue

ppendix A. Creating the 
ager queue

 appendix shows you how to create the Imager queue (in the 
ra Console, the Imager queue outputs jobs to the Cobra-8 
esetter).

e must be only one Imager queue and, typically, it has 
ady been created by the installation engineer. However, if your 
em data gets lost, becomes corrupted or you inadvertently 
te or edit the Imager queue, you will need to re-create it. You 
do this either by copying configuration files (which contain 
itions for the Imager queue) to a specific location, or by 
ually creating the Imager queue using the Queue 
figuration application.

 chapter includes the following sections:

A.1, Checking for the Imager queue (p124).

A.2, Creating the Imager queue by copying configuration files 
(p124).

A.3, Creating the Imager queue using the Queue 
Configuration application (p125).

A.4, The finished queue (p131).

A.5, Checking the new queue (p132).

A.1 Checking f
To check if the Imager

1. In the Cobra Cons

2. In the ‘Queue’ list
TicketMaker queu

3. If the Imager que
it, as described in
Imager queue bu
can check them fr

A.2 Creating th
configuration f
You can create the Ima
files into the required d
TicketMaker queues wi
re-create them. If you
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wish
as d
queu

1.

2.

3.

e Imager queue using the 
ration application
, make sure that the Completed queue 
Appendix B.

r queue using the Queue Configuration 

 Configuration application, as described in 
 ‘Queue Configuration’ window opens:

 Configuration’ window shows queues that 
 created. In this example, two TicketMaker 

ompleted queue are shown.
dix A. Creating the Imager queue

 to re-create them, then create the Imager queue manually, 
escribed in the next section. Otherwise, to create the Imager 
e by copying configuration files:

In Windows Explorer, navigate to D:\Cobra\Engine 
v1.0.1\preconfigured settings\Q2 v4.4 Config Files.

Copy the following files to D:\Cobra\Q2v4.4:
Applications.cfg
Preferences.cfg
Queues.cfg

Note: If you are asked to overwrite existing files, click on 
Yes.

WARNING: Make sure you COPY rather than MOVE the 
required files to D:\Cobra\Q2v4.4 otherwise you will 
lose the backup copy.

If necessary, re-create any TicketMaker queues, as described 
in chapter 14.

A.3 Creating th
Queue Configu
Note: Before you start
exists, as described in 

To create a new Image
application:

1. Launch the Queue
section 7.7.1. The

Note: The ‘Queue
have already been
queues and the C
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2.

e Imager for the queue’s name.

ue MUST be called Imager.

ifies the directory where the Cobra Console 
be processed.

:

ge... button to display the following dialog:

 specify the K:\PLOTDATA\BITMAPS\IMAGER 
ype the full pathname of this directory into 
click on the Browse... button to display the 
ory’ dialog, then locate and highlight the 
 on OK.
dix A. Creating the Imager queue

Click on the Add button to open the ‘Overview’ dialog:

This dialog contains a number of panels that allow you to set 
up the queue’s details. Each one is described in the following 
sub-sections.

Name

In the Name field, typ

WARNING: This que

Inputs

The ‘Inputs’ panel spec
should look for files to 

To specify the directory

1. Click on the Chan

2. Here, you need to
directory. Either t
the Path field, or 
‘Queue Hot Direct
directory and click
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3.

4.

Th

The
disp
abou

To s

1.

2.

3.

ou specify options, such as a job’s priority. 
pplied to all jobs arriving in the queue. To 
:

ge... button. The following dialog is 
dix A. Creating the Imager queue

In the ‘Inputs’ dialog, check that the correct directory name is 
shown.

Click on OK when you have finished. You will now see the 
directory listed in the ‘Overview’ dialog.

umbnail Images

 LRG application creates job thumbnail images, which are 
layed in the Cobra Console (see section 5.5 for more details 
t the LRG application).

pecify the location of the thumbnail images:

Click on the Change... button to display the following dialog:

Click on the Browse... button and locate the thumbnails 
directory, K:\PLOTDATA\VIEW\IMAGER.

Click on OK when you have finished. You will now see the 
thumbnail images directory listed in the ‘Overview’ dialog.

Job Settings

The ‘Job Settings’ let y
These settings will be a
specify the job settings

1. Click on the Chan
displayed:
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2.

3.

4.

5.

6.

n

 application that processes your jobs:

to run’ panel, click on the Change... button 
owing dialog:

 the options in the ‘Process Control’ panel.
dix A. Creating the Imager queue

In the ‘Initial settings’ panel, set the following options:

• Set the Number of copies to 1.

• Set the Initial priority to Normal.

• Set the Initial state to Not Suspended.

• Do not set the Display thumbnails for all jobs as they 
arrive in the queue option.

• Do not set the Only display thumbnail image when 
job is active option.

• Do not set the Hide this queue (unless will suspend 
on error) option.

In the ‘During Processing’ panel, select the Don’t process 
files while they are open with write access option. 

Make sure that no other options are set in this panel.

Do not change the ‘Multi-Job Settings’ option — make sure it 
is set to Process jobs individually.

Do not set any ‘File Filtering’ options.

When you have finished, click on OK to return to the 
‘Overview’ dialog.

Processes to ru

This panel specifies the

1. In the ‘Processes 
to display the foll

2. Do not set any of
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3.

4.

5.

6.

7.

8.

Pro

The
that
alwa
need

ts you specify what happens to a job after it 
 Cobra-8 platesetter. The file will be moved 
e.

ompleted’ queue already exists. If it does 
 the instructions in Appendix B.

tions:

panel click on the Change... button to 
-Up’ dialog:
dix A. Creating the Imager queue

In the ‘Process Path’ panel, click on the Browse button and 
locate the ctpimager.exe file (this can be found at 
D:\Cobra\Engine v1.0.1\).

The box This process is a Resident Process MUST be 
checked.
Note: If the This process is compatible with Q2 v3.0 box 
is checked, you need to deselect it before you can select the 
required option.

Set the Run this process as option to Hidden (no window 
visible). 

Set the Runtime priority to Normal. 

Set all other options as shown in the previous ‘Processes’ 
dialog.

When you have finished, click on OK. The ‘ctpimager’ 
application is now shown in the ‘Overview’ dialog.

cess instructions

 ‘Process instructions’ panel lets you specify the parameters 
 the Imager application should run with. As the parameters are 
ys passed to Imager from the TicketMaker queues, there is no 
 to set any process instructions.

Clean-Up

The ‘Clean-Up’ panel le
has been output to the
to the Completed queu

Note: Make sure the ‘C
not, create it following

To set the clean-up op

1. In the ‘Clean-Up’ 
display the ‘Clean
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2.

3.

4.

5.

nished, click on OK. You will now see the 
 listed in the ‘Overview’ dialog.

gement

ent’ options need to be set for the Imager 
dix A. Creating the Imager queue

Do not select the options in the ‘Error handling’ panel.

In the ‘Jobs that complete successfully’ panel, select Pass job 
to another queue (specified below).

In the ‘Next queue’ panel, click on the Browse... button and 
choose the Completed queue from the ‘Choose a Queue’ 
dialog. Click on OK.

Do not set any other options in this dialog (the previous 
dialog shows the correct settings).

6. When you have fi
clean-up directory

Resource Mana

No ‘Resource Managem
queue.
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A.4
Whe
‘Ove

o the ‘Queue Configuration’ dialog. You will 
eue in the ‘Queue Configuration’ window:

icketMaker queues then these should be 
Queue Configuration application (refer to 
uctions).

d creating the required queues, you can quit 
iguration’ dialog by clicking on the OK 
dix A. Creating the Imager queue

 The finished queue 
n you have finished creating the Imager queue, the completed 
rview’ dialog will look like this:

Click on OK to return t
now see the Imager qu

Note: If there are no T
created now using the 
chapter 14 for full instr

When you have finishe
out of the ‘Queue Conf
button.
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A.5
Now
corr

1.

2.

Not
reco
show
dix A. Creating the Imager queue

 Checking the new queue
, you should make sure that the new Imager queue is set up 
ectly in the Cobra Console. To do this:

Go to the Cobra Console’s ‘Queues’ tab. You should see the 
new Imager queue you have just created:

The Imager queue is now ready to output jobs to the Cobra-8 
platesetter.

e: When you have finished creating new queues, we 
mmend that you save the new information. Section 16.2 
s you how to do this.
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A
Co
This
the 
they
proc

Ther
alre
syst
dele
You 
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•

•

•

•

•

or a Completed queue
ted queue exists:

 Configuration application, as described in 
 ‘Queue Configuration’ window opens, 
eues that have been created, for example:

pleted queue, then you need to create it, as 
hapter. Alternatively, if there is a 

 but you think its settings may be wrong you 
om the instructions given in this chapter.

e Completed queue by 
uration files
pleted queue by copying specific 

the required directory. However, in doing 
Maker queues will be deleted, which means 
ate them. If you have a lot of TicketMaker 
to re-create them, then create the 
dix B. Creating the Completed queue

ppendix B. Creating the 
mpleted queue

 appendix shows you how to create the ‘Completed’ queue (in 
Cobra Console, jobs are moved to the Completed queue once 
 have been successfully processed. You can see all successfully 
essed jobs in the ‘Completed plates’ tab).

e must be only one Completed queue and, typically, it has 
ady been created by the installation engineer. However, if your 
em data gets lost, becomes corrupted or you inadvertently 
te or edit the Completed queue, you will need to re-create it. 
can do this either by copying configuration files (which contain 
itions for the Completed queue) to a specific location, or by 
ually creating the Completed queue using the Queue 
figuration application.

 appendix shows you how to create the Completed queue and 
des the following sections:

B.1, Checking for a Completed queue (p133).

B.2, Creating the Completed queue by copying configuration 
files (p133).

B.3, Creating the Completed queue using the Queue 
Configuration application (p134).

B.4, The finished queue (p137).

B.5, Checking the new queue (p138).

B.1 Checking f
To check if the Comple

1. Launch the Queue
section 7.7.1. The
showing all the qu

2. If there is no Com
described in this c
Completed queue
can check them fr

B.2 Creating th
copying config
You can create the Com
configuration files into 
this, all existing Ticket
you will have to re-cre
queues or do not wish 
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Com
Othe
conf

1.

2.

3.

e Completed queue using 
figuration application
eted queue using the Queue Configuration 

 Configuration application, as described in 
 ‘Queue Configuration’ window opens:

 Configuration’ window shows queues that 
 created. In this example, the Imager 

cketMaker queues are shown.
dix B. Creating the Completed queue

pleted queue manually, as described in the next section. 
rwise, to create the Completed queue by copying 
iguration files:

In Windows Explorer, navigate to D:\Cobra\Engine 
v1.0.1\preconfigured settings\Q2 v4.4 Config Files.

Copy the following files to D:\Cobra\Q2v4.4:
Applications.cfg
Preferences.cfg
Queues.cfg

Note: If you are asked to overwrite existing files, click on 
Yes.

WARNING: Make sure you COPY rather than MOVE the 
required files to D:\Cobra\Q2v4.4 otherwise you will 
lose the backup copy.

If necessary, re-create any TicketMaker queues, as described 
in chapter 14.

B.3 Creating th
the Queue Con
To create a new Compl
application:

1. Launch the Queue
section 7.7.1. The

Note: The ‘Queue
have already been
queue and two Ti
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2.

e Completed for the queue’s name.

ue MUST be called Completed.

ifies the directory where the Cobra Console 

:

ge... button to display the following dialog:

 specify the K:\PLOTDATA\BITMAPS\COMPLETE 
ype the full pathname of this directory into 
click on the Browse... button to display the 
ory’ dialog, then locate and highlight the 
 on OK.
dix B. Creating the Completed queue

Click on the Add button to open the ‘Overview’ dialog:

This dialog contains a number of panels that allow you to set 
up the queue’s details. Each one is described in the following 
sub-sections.

Name

In the Name field, typ

WARNING: This que

Inputs

The ‘Inputs’ panel spec
should look for files.

To specify the directory

1. Click on the Chan

2. Here, you need to
directory. Either t
the Path field, or 
‘Queue Hot Direct
directory and click
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3.

4.

Th

The 
Cob
app

To s

1.

2.

3.

to be set for the Completed queue.

n

panel specifies the application that 

to run’ panel, click on the Change... button.

ntrol’ panel, select the This queue runs no 
.

urn to the ‘Overview’ dialog.
dix B. Creating the Completed queue

In the ‘Inputs’ dialog, check that the correct directory name is 
shown.

Click on OK when you have finished. You will now see the 
directory listed in the ‘Overview’ dialog.

umbnail Images

LRG application creates job thumbnail images for display in the 
ra Console (see section 5.5 for more details about the LRG 
lication).

pecify the location of the thumbnail images:

Click on the Change... button to display the following dialog:

Click on the Browse... button and locate the thumbnails 
directory, K:\PLOTDATA\VIEW\COMPLETE.

Click on OK when you have finished. You will now see the 
thumbnail images directory listed in the ‘Overview’ dialog.

Job Settings

No ‘Job Settings’ need 

Processes to ru

The ‘Processes to run’ 
processes your jobs:

1. In the ‘Processes 

2. In the ‘Process Co
processes option

3. Click on OK to ret
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Pro

For 
instr

Cle

For 
opti

Re

For 
Man

d queue 
d creating the Completed queue, the 
ok like this:
dix B. Creating the Completed queue

cess instructions

the Completed queue, there is no need to set any ‘Process 
uctions’.

an-Up

the Completed queue, there is no need to set any ‘Clean-Up’ 
ons (they should be set to Leave jobs where they are).

source Management

the Completed queue, there is no need to set any ‘Resource 
agement’ options.

B.4 The finishe
When you have finishe
‘Overview’ dialog will lo
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Click
now
wind

If th
the 
instr

If th
now
instr

Whe
Con
retu

he new queue
 sure that the Completed queue is set up 
Console. To do this:

onsole’s ‘Completed plates’ tab.

 the Completed queue correctly, you will 
er queues listed (assuming some have 

r example:

finished creating new queues, it is a good 
formation. Section 16.2 shows you how to 
dix B. Creating the Completed queue

 on OK to return to the ‘Queue Configuration’ dialog. You will 
 see the Completed queue in the ‘Queue Configuration’ 
ow:

ere is no Imager queue then this should be created now using 
Queue Configuration application (see Appendix A for 
uctions).

ere are no TicketMaker queues then these should be created 
 using the Queue Configuration application (see chapter 14 for 
uctions).

n you have finished, you can quit out of the ‘Queue 
figuration’ dialog by clicking on the OK button. You will be 
rned to the Cobra Console.

B.5 Checking t
Now, you should make
correctly in the Cobra 

1. Go to the Cobra C

2. If you have set up
see any TicketMak
been created), fo

Note: When you have 
idea to save the new in
do this.
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C.1
BPR
that
requ
dam
off t

The 

It is
repr

 made up as follows:

er (0-9) allows you to have up to ten 
BPR, all applying unique barcode numbers. 
r also lets you identify which system a plate 
See section C.3 for more information about 
 number.)

ication number is used to identify the 
 number starts at 0 and increments by 1 for 
output.

in the barcode is the check digit.

 barcode is held for 28 days since the plate 
 time limit is exceeded, a ‘Cannot find a 
is identifier’ message is displayed when you 
late in the Cobra Console. Refer to 
tails about this.

482-9207
entification number

Check digit
dix C. Setting up Barcode Plate Requeue

ppendix C. Setting up 
rcode Plate Requeue

Barcode Plate Requeue (BPR) option is a barcode system that 
you locate and re-output jobs with ease.

 chapter describes:

C.1, An introduction to BPR (p139).

C.2, Setting the BPR preferences (p140).

C.3, Configuring BPR (p141).

e: Using BPR to re-output plates to the Cobra-8 platesetter is 
red in section 7.5.

 An introduction to BPR
 lets you add a barcode with a unique reference number to jobs 
 are output to the Cobra-8 platesetter. If a job needs to be 
eued in the Cobra Console (for instance, if a plate gets 
aged), you can simply do this by scanning the plate’s barcode 
he plate or manually typing in the barcode number.

barcode is 5 x 80 mm in size and looks like this:

 made up of the barcode itself and a 12 digit number 
esenting the barcode.

The 12 digit number is

• The series numb
systems running 
The series numbe
has come from. (
setting the series

• The plate identif
plate/image. This
each subsequent 

• The final number 

The record of a plate’s
was last output. If this
completed plate with th
attempt to requeue a p
section 7.5 for more de

1000-3
Plate id

Series number
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C.1.

The 
expo
the 

By d
spec
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ima

 BPR preferences
nces:

onfig software (refer to section 7.7.1 for 
 ‘BPRConfig’ dialog is displayed.

rences... button to display the following:

rement Units (choose from Millimetres or 

ecessary to specify margins to be added 
e. However, if you want to set margins, use 
op and Bottom fields in the ‘Barcode 

argins, ensure that the barcode will not 
 image or any crop or registration marks.

 BPR on more than one system, with each 
g unique barcodes, then select a Series 
n 0 and 9) from the pull-down list. This 
l be the first digit on all barcodes output 
r Cobra machine.

 Stitch in imager queue option.

d setting the preferences, click on OK to 
ig’ dialog.
dix C. Setting up Barcode Plate Requeue

1  Barcode positioning

barcode can be positioned anywhere in the image that will be 
sed to the plate (regardless of how the image is oriented on 

plate), for example:

efault, the barcode is positioned with no offset from the 
ified corner of positioning (as shown above) so you may need 
-position it to avoid crop marks, registration marks or the 

ge itself. (Repositioning the barcode is covered in section C.3.)

C.2 Setting the
To set the BPR prefere

1. Launch the BPR C
details). The main

2. Click on the Prefe

3. Select the measu
Inches).

4. It should not be n
around the barcod
the Left, Right, T
margins’ panel.
Note: If you set m
print over the job

5. If you wish to use
system generatin
number (betwee
series number wil
from the particula

6. Do not select the

When you have finishe
return to the ‘BPRConf
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C.3
Not
Cob

To c
Cob

1.

2.

3.

osition’ panel, enter the Horizontal and 
of the barcode then select the From left-
ge or From right-hand side of image 

he From top of image or From bottom of 
is allows you to place the barcode in any 
ive to any plate edge.
de will be positioned within the image 
that it will not print over crop or registration 
ge itself.

x 80 mm in size.

e Rotation from the pull-down menu. 
0, 180 and 270 degrees:

ion 90° rotation

ation 270° rotation
dix C. Setting up Barcode Plate Requeue

 Configuring BPR
e: Before you start, make sure you have created the required 
ra Console/TicketMaker queues, as described in chapter 14.

onfigure BPR to add barcodes to the jobs output by the 
ra-8 platesetter:

Launch BPR Config if it is not already running (refer to 
section 7.7.1 for details on how to do this). The main 
‘BPRConfig’ dialog is displayed:

From the Name pull-down list, select the required 
TicketMaker queue (a barcode will be added to all plates in 
this queue).

Check the Add barcode box.

4. In the ‘Barcode p
Vertical position 
hand side of ima
option, and also t
image option. Th
position and relat
Notes: The barco
border so ensure 
marks, or the ima

The barcode is 5 

5. Select the barcod
Choose from 0, 9

0° rotat

180° rot
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6.

7.

8.
dix C. Setting up Barcode Plate Requeue

Check the Negative images box if the barcode is to be 
output in negative.
Note: If the barcode is to be read with a barcode reader, it 
must appear as black stripes and text on a light background 
on the plate. In nearly all cases, the Negative images option 
should not be selected.

If you wish to add barcodes to other Cobra-8 queues, follow 
the instructions in this section (steps 2 to 6) again.

When you have finished, click on OK to close the BPR Config 
program.
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